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Preface

PREFACE Welcome

Purpose of This Manual

• Chapter 1 is a generic overview of the Visionscape product family.

• Chapter 2 describes the FrontRunner user interface.

• Chapter 3 is a guide to camera calibration using FrontRunner.

• Chapter 4 provides specific information about the Part Queue.

Manual Conventions
The following typographical conventions are used throughout this manual.

• Items emphasizing important information are bolded.

• Menu selections, menu items and entries in screen images are 
indicated as: Run (triggered), Modify..., etc.
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CHAPTER 1 Visionscape Overview

This chapter covers the basic Visionscape concepts in terms of the 
hardware and vision application development.

Introduction

At its highest level, Visionscape is a set of software and hardware that 
allows you to create and operate machine vision applications without 
having to consider the details of data connection and information flows in 
the software or how the underlying hardware is configured.

All Visionscape applications, commonly referred to as “jobs,” have the 
following components and characteristics:

• A Machine Vision Program — Commonly referred to as an “AVP” or 
“job”. A job is a collection of Visionscape steps.

• Visionscape Steps — Steps are completely encapsulated machine 
vision operations and tools. Steps pass information to each other and 
take care of all hardware and memory management. A Visionscape 
job is a tree of steps. The order of the tree defines the order of 
execution and flow of data.

• A Vision System Step is present at the top of each job. The Vision 
System Step represents the hardware on which the job is to run - 
either a smart camera, a Vision System comprised of GigE Cameras, 
or a software system.

• All Steps contain Datums, which represent the inputs to and outputs 
from a Step or Tool.
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Visionscape Product Family
The hardware platform on which Visionscape Software runs is generically 
called a vision system. Visionscape supports several types of vision systems:

• MicroHAWK Smart Camera — A networked smart camera for use in 
machine vision and traceability applications. It features integrated 
lighting, optics, image processing, I/O, and communications.

• Visionscape Software System — Visionscape can mimic a hardware 
system by running a software emulator (SoftSys). The software system 
may be used for application development using stored images. A 
software key is typically required for full Visionscape operation.

• AutoVISION Software — Visionscape software is also the basis for 
AutoVISION, which is intended for vision applications of basic to 
moderate complexity. It allows process engineers and manufacturing 
engineers with minimal machine vision experience to deploy a system 
that meets their traceability, inspection, and quality control requirements.
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Visionscape FrontRunner Overview

FrontRunner is an application development and monitoring GUI. 
FrontRunner gives you full access to Visionscape tools.

Note: You must have Administrator privileges to install and run 
AutoVISION and Visionscape.

Using FrontRunner, you can:

• Train, try out, and download a job to a Vision System (see Figure 1-1).

FIGURE 1–1. Train, Try Out, and Download
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• Assemble jobs and adjust parameters (see Figure 1-2).

FIGURE 1–2. Assemble Jobs and Adjust Parameters
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• Monitor a Vision System (see Figure 1-3).

FIGURE 1–3. Monitor Vision System
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• Monitor results (see Figure 1-4).

FIGURE 1–4. Monitor Results

The Visionscape toolkit is comprehensive, and includes:

• Image preprocessing 

• Image arithmetic, warping, binary and gray scale morphology, edge 
enhancement, other filtering, etc

• Image analysis 

• Flaw detection, blob analysis, edge detection and fitting, vector edge 
detection, template find, etc

• Calibrated dimensional measurements

• Line intersection, point to point distance, point to line normal, etc. 

• Automatic identification 

• Data Matrix and barcode reading, OCR, etc

• Custom processing options

• Custom measurements and custom scripted tools
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Setup and Runtime
When working with Visionscape applications, you access the Visionscape 
Vision hardware in one of two modes:

• In Setup mode, the setup objects control the hardware. You can train 
and try out tools and debug your vision application.

• In Runtime mode, you download your vision applications to the 
runtime hardware objects for full speed operations. The runtime 
objects control the hardware, and the setup objects cannot be used to 
edit the job. You can start and stop vision inspections at runtime, as 
well as receive inspection results and runtime images.

Note: Setup and Runtime modes are mutually exclusive. That is, only one 
mode can control a vision system.
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Visionscape 8.x Firmware

Note: If you open a Visionscape 6.x job using Visionscape 8.x, the job 
automatically becomes a 7.x job, even if no changes are made to the job.

You can monitor, but not program, a 6.x job on a smart camera with 
FrontRunner. Also, you can upload a 6.x job and save it to your PC, at 
which time it becomes a 7.x job.
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The IntelliFind® Tool

IntelliFind is a very capable and robust object locator tool that is invariant 
to many changes in the images, such as contrast, intensity variation, 
scale, translation, rotation, noise, and occlusion. IntelliFind allows a 
feature or object to be found, and it can significantly reduce the 
complexity of locating features in an image. It is well suited where an 
object reference must be found before it is inspected or gauged.

When building a job in FrontRunner (for more information, see Chapter 
2), you can insert an IntelliFind tool by selecting it from the Insert Tool 
dialog box (Image/Pre-Processing tab). You can always insert and use 
IntelliFind in a job, even if a key cannot be found to unlock it. In this case, 
IntelliFind runs in demonstration mode, with recurring messages 
requesting that you insert the key. You can make changes to try out the 
job, but you cannot save the job to disk. When connected to a smart 
camera IntelliFind model, no hardware dongle is required to try out the 
job. Essentially, the camera acts as a hardware dongle, but only for that 
camera currently selected in FrontRunner (focused device).

Note: You cannot upgrade a non-IntelliFind smart camera in the field.
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Visionscape Software Structure and Concepts

Steps and Trees
A Step represents a piece of vision functionality in Visionscape. 
Applications are a collection of steps. To provide order to this collection, 
the steps are arranged in a Tree. The Tree represents not only the 
containment of a set of steps, but also represents a data connection 
between these steps. In other words, a step can receive a set of data 
inputs, act on this data, and produce a set of data outputs. The tree 
represents the connection of particular data outputs to data inputs.

The most common piece of data to be passed from one step to another is 
a buffer. A buffer is a piece of memory that contains image data.

In Figure 1-5, a Snapshot generates a buffer that is passed to the Sobel 
Filter. The Sobel Filter then executes a Sobel algorithm on the buffer and 
generates a new buffer, which is passed to the Edge Tool. The Edge Tool 
finds an edge on that buffer and reports a result. A step that generates 
output can have other steps or tools inserted into it. The inserted tools 
then connect their inputs to the outputs of the parent step.

FIGURE 1–5. Sample Job Tree

Many tools also have a region of interest (ROI) that defines an area on 
the input buffer for that tool. In the case of the Sobel Filter, the ROI 
defines the area where the Sobel Filter executes its algorithm. Its output 
buffer (or input buffer to the Edge Tool), is the size of its ROI.

Many steps are not vision based steps like Sobel Filter or Edge Tool, but 
actually represent other useful pieces of functionality like I/O, image 
acquisition, or a thread-of-execution. Several steps are common to every 
job you create. These are Job, VisionSystem, Inspection, and 
Snapshot/Acquire.
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Job Step
The Job Step is the root of all steps in the Job Tree. When you create a 
new application, you are creating a new job that contains a Vision System 
Step that represent the Visionscape Vision System installed in the 
system. A Vision System is an object that can use hardware to execute 
vision. The hardware can be a GigE camera, a smart camera, or software 
that is not connected to any specific hardware at all. The Job Step 
contains all Vision System Steps in the tree and is used as the single 
entry point of the tree.

The Job Step performs no special function and does not contain any 
results. Essentially, the Job Step is a collection of Vision System Steps. 
Each Vision System Step represents a single Visionscape Vision System, 
but the Job Step represents a set of Visionscape Vision Systems (see 
Figure 1-6).

FIGURE 1–6. Job Tree

In Visionscape 8.x, FrontRunner can open and save single Vision System 
Step files. This opens or saves a specific Vision System Step tree rather 
than all systems at once, allowing you to work with each system 
exclusively.

Visionscape Vision System #1 (Vision System Step)

Job Container Step

Inspection Step
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Vision System Step
The Vision System Step is the step representation of a Vision System 
itself. A Vision System is an object that can use hardware to execute 
vision programs. The hardware can be a GigE Camera, a smart camera, 
or software that is not connected to any specific hardware at all. The 
Vision System Step can take control of a specific Vision System on the 
AvpBackplane, and can be changed later to assume a different Vision 
System. The Vision System Step has parameters that allow you to set the 
camera type to be used by the system, set the parameters of the 
bufferpool for this Vision System, and set the general purpose I/O 
configuration. Essentially, the step provides the parameters to configure 
the actual hardware of the Vision System.

The Vision System Step also contains all the Inspections that are used by 
the Vision System, as shown in Figure 1-7.

FIGURE 1–7. Three Inspections
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Inspection
The Inspection Step represents one thread of execution for your vision 
application. The Inspection is the entry point for execution whether you 
are setting up your application or executing your application. You can 
create any number of Inspections in a Vision System, and each can be 
started and stopped asynchronously. In a typical inspection, you use a 
Snapshot/Acquire to acquire an image, execute vision tools on that 
image, and then report results either through I/O or through the Inspection 
Report.

Creating multiple inspections allows you to create inspections with tools 
that execute either synchronously or asynchronously.

Note: The preceding statement is generally applicable to Visionscape. In 
the case of smart cameras: while multiple inspections are still supported, 
care should be taken to make sure that multiple Snapshot steps do not 
attempt to use the single “camera” at the same time.

In Figure 1-8, the job contains two Inspection steps renamed to Flaw 
Inspection and Data Matrix Inspection for clarity.



Chapter 1 Visionscape Overview

1-14 Visionscape FrontRunner User Manual 

FIGURE 1–8. Job with Multiple Inspection Steps

The Flaw Inspection contains two Snapshots. The first Snapshot (11) 
contains a Flaw tool that might be used to detect scratches on a part. The 
second Snapshot (12) in this inspection might be taken at a longer 
exposure to detect some subtle defects in a specified region. Because 
Snapshot 12 follows Snapshot 11 in the same inspection, it will not take 
place until the Flaw tool runs. Snapshot 21 is in a separate inspection. 
Both it and Snapshot 11 should be separately triggered in a manner that 
will ensure that they do not both use the sensor at the same time.
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Snapshot and Acquire
The Snapshot and Acquire steps work together to provide image 
acquisition capabilities for the job. Acquire is the image creator; Snapshot 
is the image receiver.

Acquire is a special step that knows how to capture images from the 
camera or disk, utilizing triggers and strobes. You can program the 
camera selection, trigger, and strobe in the Acquire step. When 
executing, the Acquire sets up the Camera I/O Card or smart camera 
digitizer according to your selection and captures images into a list, called 
a frame list. When an image is set into the list, the Snapshot can then pull 
the frame from the list and turn it into a buffer that is then passed along to 
its contained steps.

The execution of the Acquire depends on your trigger selection. The letter 
“P” at the left of the Acquire step in the job Tree means the Acquire step is 
a preprocessing step of the Snapshot. Though it is a child of the 
Snapshot, it is executed before the Snapshot. When no triggers are 
selected (see Figure 1–8, “Job with Multiple Inspection Steps,” on 
page 1-14), the Flaw Inspection tree is executed in the following order:

• Acquire

• Snapshot

• FlawTool1

• Acquire

• Snapshot

• Flaw Tool2

• Digital Outputs Step

This changes when you select a trigger. In order to maximize image 
acquisition along with inspection execution, when a trigger is selected, the 
images are pipelined to the running Inspection. The hardware acquires 
images from the camera when the trigger is fired using the appropriate 
acquisition definition and instruct the Acquire Step that an image frame 
(or buffer) is available. The Acquire Step creates a Frame Datum from the 
image and pushes it onto its frame list. The Snapshot, running within the 
Inspection thread, will remove the images from the frame list when it 
executes. In this way, a triggered acquisition pipelines the image to the 
running inspection. This allows multiple images to be captured so the 
vision on the system production line does not miss parts.
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Jobs

Jobs and Storage in Non-Volatile Memory
To determine the size of an avp job from FrontRunner, select File > Show 
Job Info... and navigate to the avp file on the disk. FrontRunner displays a 
dialog that shows the File Size of the avp and other statistics about the job.

FIGURE 1–9. File Size of Job

Determine support file sizes by adding up the file sizes of the models, 
fonts, perl scripts, and tiff images used in the avp (these are usually 
stored in \Vscape\Jobs). Overall, the maximum size used (avp + support 
files) cannot exceed the 16MB (or 6MB) available in flash memory.

Combining Jobs for Operation as a Multi-Inspection Job 
Because the smart camera Non-Volatile Memory file system does not 
support multiple separate avp files in this release, separate inspection 
jobs that would live in separate avp files for other devices must be 
combined into a single avp with multiple inspections for the purpose of 
running on the smart camera. This is done by loading each avp into a 
separate Software System (which does not change the camera definition 
selected and other system dependent parameters like IO assignment), 
and then copying all the Inspections of the second avp and pasting them 
into the first avp. Then, the first avp can be saved to disk and 
loaded/flashed later onto the desired device.
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CHAPTER 2 FrontRunner

Overview
FrontRunner is a comprehensive vision development environment you 
use to create, edit, try out, and run vision applications.

When working with Visionscape applications, you access the Visionscape 
Vision hardware in one of two modes:

• In Setup mode, the setup objects control the hardware. You can train 
and try out tools and debug your job.

• In Runtime mode, you download your job to the GigE Camera or 
smart camera for full speed operations. The runtime objects control 
the hardware; the set-up objects cannot be used to edit the job. You 
can start and stop vision inspections at runtime, as well as receive 
inspection results and runtime images.

Note: The Setup and Runtime modes are mutually exclusive – only one 
mode can control a vision system.

FrontRunner supports single or multiple Visionscape vision systems. You 
can create and save vision jobs in FrontRunner, train tools, examine 
Inspection reports, and monitor I/O activity. FrontRunner is equally 
applicable to Visionscape GigE Camera products and smart camera 
vision systems. It is the GUI you should use to develop and train vision 
applications for the smart camera.

A shortcut for starting FrontRunner is located at Start > Microscan 
Visionscape > Visionscape FrontRunner.



Chapter 2 FrontRunner

2-2 Visionscape FrontRunner User Manual

Basic Concepts
Before you do anything with your smart camera, make sure it is mounted 
properly and wired correctly. 

Device Toolbar and Device Buttons
When you start FrontRunner for the first time, if you have not installed any 
Visionscape cameras, you will see a Device Toolbar that contains no 
devices other than the vision system emulator (SoftSys1) (Figure 2-1).

FIGURE 2–1. Device Toolbar with No Devices

You can add devices to the toolbar with the procedure shown below.

Adding and Controlling a Smart Camera
When you look at the devices on your network, you’ll see numerous 
cameras. Before you can build a job to read a part on any of those smart 
cameras, you have to “add” the camera so that it is connected to your PC. 
After you add the camera, and before you start building a job, you have to 
take control of the camera on which you want to build a job. Other users 
can still see the camera on the network, they just can’t do anything with it 
while you have control. To add a camera:

1. With a smart camera that is properly and securely mounted, and 
connected to the network, start FrontRunner (either double click the 
FrontRunner icon, or select Start > Visionscape > Visionscape 
FrontRunner). FrontRunner starts up and displays its main window.

2. Click Add Btn. FrontRunner displays the Select Device dialog box.

3. Highlight a camera name and click OK. FrontRunner adds the new 
smart camera icon to the Device Toolbar, as shown in Figure 2-2:
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FIGURE 2–2. Device Toolbar with Smart Camera

Now that you’ve added the smart camera, you’ll want to control the 
camera so that no other users can use it while you’re creating your job. To 
control the camera:

1. Click on the camera button for the smart camera you just added.

2. Click Take Control. FrontRunner displays the Login to Device dialog 
box.

3. Type in a user name.

4. Click OK. Now you have control of the camera.

5. Click Create New Program to begin the process of building a job. 
FrontRunner displays its main window, which contains the key steps 
that are a part of every job.

Before you build your job, you so read the fhepul ollowing information 
about the Acquire Step, the Snapshot Step, and the Vision System Step.

Note: Clicking the right mouse button while positioned over the camera 
icon presents the operator with the option to “Remove this button” or 
“Reboot this device”. The first option removes the icon from the Device 
Toolbar. The second option reboots the camera provided you have control 
of the device.
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Important Visionscape Steps
After you click Create New Program, and before you add any steps or 
tools to your job, we’ll look at the following steps, which are key steps in a 
Visionscape job:

• The Acquire Step

• The Snapshot Step

• The Vision System Step

The Acquire Step
The Acquire step is one of the most important steps in Visionscape, since 
it is the step where you can specify the following:

• Acquisition method, which is how the camera acquires images. 
Acquisitions can be triggered or non-triggered.

• Gain and Offset, which determine what is applied to the incoming 
video signal.

Note: The Visionscape Tools Reference contains detailed information 
about Gain and Offset:

Chapter 1 describes these advanced datums on the Acquire 
properties page.

Chapter 13 describes the GainOffset Filter in detail.

• Exposure time, which is the amount of time, in micro seconds, that 
the camera’s CCD will integrate light. Exposure Time can freeze 
motion when not using a strobe, or if you are using a strobe, it can 
prevent ambient light from affecting your image.

• Photometry and Lighting, which is the light source powered by the 
camera.

• Triggers, which can be virtual or physical

The Acquire step is inserted automatically as a component of the 
Snapshot step. There is always a one-to-one relationship between 
Acquire and Snapshot. For complete information about the Acquire step, 
see Chapter 1 of the Visionscape Tools Reference.
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The Snapshot Step
After the Acquire step acquires images, the Snapshot step pulls the 
image frames from the frame datum list and passes them on to the vision 
tools in the inspection for further processing.

When steps are inserted into a Snapshot, all their input buffer datums are 
automatically connected to the output buffer datum of Snapshot. The 
output buffer datum of Snapshot is the last image acquired. These steps 
then process or analyze this image.

The Snapshot step also defines a point of calibration in the step tree. 
When calibrated, the Snapshot contains a special Part tree that defines 
the calibration data. A typical calibration job is simply a Blob Step. The 
Blob Step is used by the Calibration Manager to find the calibration blobs 
in the image and update its “PhysCalDots” Point List datum, calculate the 
calibration matrices, then update the Calibration Result Datum in the 
Snapshot. The Calibration Result Datum (“CalResult”) contains the mean 
and max residuals, the pixels per unit and units per pixel in x and y, the 
camera angle, and the UX and VY perspectives. For complete information 
about the Snapshot step, see Chapter 1 of the Visionscape Tools 
Reference.

The Vision System Step
The Vision System step represents the vision system device that 
performs the inspection and can be a smart camera, GigE Camera, or 
software system. Some features, which you can configure, include:

• Buffer counts

• Camera selection

• Digitizer and digitizer mode

• I/O point configuration

A Vision System step is always created with an Inspection step, which 
represents an inspection task. You can add additional inspection steps. 
Multiple inspection steps are necessary when an application has to 
support multiple asynchronous inspections.
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I/O consists of both physical I/O and virtual I/O. Virtual I/O provides the 
PC with a set of I/O points that behave much like physical I/O points, but 
can only be accessed by software. They have the advantage of being 
both inputs and outputs at the same time, and they can hold 32-bit values 
instead of a binary state. This enables software on the PC to 
communicate with the job using a mechanism that is conceptually similar 
to using physical I/O but without requiring special hardware and wiring. By 
default, the system has 2048 virtual I/O points. For complete information 
about the Visions System step, see Chapter 1 of the Visionscape Tools 
Reference.

Focus and Lighting
Now that you have control of a smart camera, it’s time to place a part in 
front of the lens and adjust the focus using Live Video. Live Video shows 
you exactly what the smart camera sees in real time. You want the part to 
be as clear and distinct as possible. Use the Zoom buttons (just to the 
right of the Live Video button) to enlarge the part as needed.

Lighting is extremely important for machine vision. If the part you want to 
read is not properly illuminated, then the results will be less than optimal. 
When lighting a part, consider the following:

• Surface Characteristics

• Geometry

• Size

• Region of Interest (ROI)

These considerations will determine what type of light you need to 
adequately illuminate your part. 

Exposure Time
Depending on the lighting you use, you may have to adjust the exposure 
time for the camera. Exposure time is the amount of time, in micro 
seconds, that the camera’s CCD integrates light. Exposure time can 
freeze motion when you are not using a strobe or, if you are using a 
strobe, it can prevent ambient light from affecting your image. You set the 
exposure time in the Exposure Time (us) property on the Acquire Step 
properties page from the Editor window. For more information about the 
Exposure Time (us) property in the Acquire Step, see Chapter 1 of the 
Visionscape Tools Reference. For more information about the Editor 
window, see “The Editor Window” on page 2-36.
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Steps and Tools
We’ve seen that every Visionscape job starts with the same steps (Vision 
System, Inspection, Snapshot, Acquire). From this point on, it’s up to you 
to add the steps and tools, building the job, that accomplishes the task 
that you want to accomplish. Visionscape tools fit into the following 
categories:

• Analysis tools

• Image and Pre-processing tools

• Measurement tools

• Program control tools

• Script tools

For complete information about Visionscape tools, see the Visionscape 
Tools Reference.

Adding Steps and Tools
Now that we’re at the main FrontRunner window, it’s time to add one or 
more tools. The procedure would be similar to the following:

1. Open the Editor window.

2. Add a tool.

3. Adjust properties.

4. Close or minimize the Editor window.

5. Acquire an image

6. Adjust the tool’s region of interest (ROI).

7. Train the tool, if applicable.

8. Try out the job.

9. Download the job to the smart camera.

10. Start the job on the smart camera.
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Training and Untraining Tools
Some tools (like the Barcode Tool and the Data Matrix Tool) can be 
trained. When you train a tool, you’re “telling” the tool what to expect 
when it reads an image. For example, if you train the Data Matrix tool to 
read a Data Matrix with 12 rows and 12 columns, the Data Matrix tool will 
fail when it encounters a Data Matrix with 16 rows and 16 columns.

You can untrain a tool that’s been trained. When you untrain a tool, you 
are effectively “opening it up” to read a larger variety of images. For 
example, if you untrain the Data Matrix tool that was trained to read a 
Data Matrix with 12 rows and 12 columns, it will read a Data Matrix with 
12 rows and 12 columns, 16 rows and 16 columns, and so on.

Trying Out a Job
After you’ve built your job, and before you’ve downloaded it to a device to 
run it, you’ll want to try out the job on the PC, to fine tune it. FrontRunner 
allows you to try out a step, try out the entire job on one image, or try out 
the entire job on multiple images.

Note: In the Settings dialog box , notice the Acquire Images During 
Try Out option. When this option is checked, FrontRunner loads each 
image that you specified in the Acquire step, one at a time. If you uncheck 
this option, and click Try Out Program on PC Once and then Stop 
repeatedly, your job will run on only the image that is loaded currently.

Downloading a Job
After you’ve tried out the job and confirmed that it runs as you want it to, 
you can download it to the device using Download Program from PC to 
Device.

Saving a Job
Use the Save Program button to save the current job to disk on the PC. If 
the job already resides on disk, FrontRunner will simply save the job 
without displaying the Save Job dialog box. If you want to save the 
current job with a different name, select File > Save Job As. In the File 
name text box, type a different name for the job you want to save, and 
then click Save.

Note: If the current job changes through editing, the Save button is red.
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Saving an Image
Right click on the image. In the menu that is displayed (Figure 2–3), 
select Save Image... to save the current image to the disk on the PC. 
When the Save As dialog box is displayed, enter a name for the image 
you are saving.

FIGURE 2–3. Menu Displayed — Save Image

Starting a Job
Start the job on the device by clicking Start Program on Device.
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Advanced Concepts

Multiple Views

FIGURE 2–4. Control Bar, Snap Views, Device View, and Inspection 

Reports

FrontRunner allows you to view up to four inspections at a time. You 
define what and how information is displayed.

You can add or remove multiple views simply by clicking Snapshot 
buttons in the Control Bar.

Note: Even though the Image Rate and selectors apply conceptually to a 
single Snapshot, within the same inspection, all image views share the 
same rate and selector. The last settings done to any image views applies 
to all the image views in that Inspection, regardless of which Image view 
rate and selector was changed. 

Snap View 1 Snap View 2

Snap View 3 Snap View 4

Control Bar

Device View
Inspection Report 1
Inspection Report 2
Inspection Report 3
Inspection Report 4



Advanced Concepts

F
ro

n
tR

u
n

n
er

2

Visionscape FrontRunner User Manual 2-11

The FrontRunner window has four major areas in the Runtime view:

• Control Bar — This toolbar allows you to select Inspections with their 
associated Snapshot (Camera views). There is a Camera view button 
for the focused Inspection to add/remove Snapshot view while the 
device (smart camera or GigE Camera) is running. You can select the 
layout to determine how the views are to be arranged for a particular 
Inspection. Use the Ctrl key to select multiple Snap Views.

• Snap View Area — This area displays the selected Snapshot views 
for the Inspection based on the layout you select. You can zoom the 
image, save graphics, and change the view refresh rate and freeze 
mode by operating a drop-down menu in the Snapview of interest.

• Inspection View Area — In this area, you can display output datums 
results and timing information. You can also show results associated 
with this Inspection.

• Device View — In this area, you operate controls to define a set of I/O 
buttons and status lights that monitor the device I/O or generate 
virtual triggers for any Inspections running on the device, either one 
shot or periodic (you enter the period).

Figure 2–5 shows four Snap views, with zoom buttons and drop-down 
menus expanded.
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FIGURE 2–5. Four Snap Views, Zoom Buttons and Drop-Down Menus

• Save Current Image — Saves the current image as either a .tif file or 
a .bmp file. You will be prompted to specify a file name. You can 
specify where the file will be saved.

Zoom to actual size

Zoom out

Zoom in



Advanced Concepts

F
ro

n
tR

u
n

n
er

2

Visionscape FrontRunner User Manual 2-13

• Select Folder — Displays the Browse For Folder dialog box, which 
allows you to specify where images and reports are saved. Use the 
New Folder button to create a new folder for images and reports.

• With Graphics / Without Graphics — Specifies whether or not you 
want to include tool graphics with the saved images.

• Save None / Save All Images / Save Failed Images / Save Passed 
Images — Specifies what images you want to save (if any).

• Show Tool Graphics — By default, FrontRunner displays the tool 
graphics with the captured image.

• All Images / Failed Images — Specifies what kind of images 
FrontRunner should display.

Note: Any change you make apply to all snapshots in the Inspection.

• Freeze This / Freeze Next Failed / Freeze Last Failed — Specifies 
which image FrontRunner should freeze.

Note: Any change you make apply to all snapshots in the Inspection.

• Maximum Rate w/drops / ... / Every Image (no drops) — Specifies the 
rate at which FrontRunner should display images.

Note: Any change you make apply to all snapshots in the Inspection.

When the image rate is set to Maximum Rate w/Drops or any of the 2, 
4, or 8 per second rates, priority is given to the running of the 
Inspection such that images are sent only when there is enough idle 
time to do so (for example, while waiting for the next image to be 
acquired from the camera). If there is little or no idle time, then the 
Image view may refresh very slowly and appear to either show 
always the same image or not refresh any image at all. This can 
happen in the most extreme cases in full pipeline with no idle time left; 
in this case, the display will freeze for long periods of time. If seeing a 
“live” image is required, then the avp should be designed to allow for 
some idle time while still maintaining the inspection rate required by 
the external triggering source. A special case of this are Software 
Systems which do not have Hardware to assist in producing idle time 
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(for example, while the digitizer is sending the image to memory). For 
this special case, either select the Every Image (no drops) or insert a 
WaitStep in the avp with a small wait time (let say 10 msec) to allow 
the image to be rendered on the screen.

Figure 2–6 shows four inspections, with output information displayed for 
the first inspection.

FIGURE 2–6. Output Information for Inspection 1

Figure 2–7 shows four inspections, with timing information displayed for 
the first inspection.
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FIGURE 2–7. Timing Information for Inspection 1
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Figure 2–8 shows four inspections, with extended information displayed 
for the first inspection.

FIGURE 2–8. Extended Information for Inspection 1
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Software Systems
Software Systems are full featured devices (Visionscape 8.x supports up 
to two Software Systems). Software Systems support Load Images from 
File mode to acquire an image while running in offline mode. Software 
Systems are not simulators or emulators of a GigE Camera or smart 
camera. Jobs that run on a Software System use the CPU resources and 
memory of the host PC. A dongle is required to run jobs on a Software 
Systems fully; otherwise, the jobs can be loaded or modified and run on a 
Software System, but they cannot be saved (this is the demonstration 
mode of Visionscape).

When loading a job created for a supported device, either GigE Camera 
or smart camera, the job is not changed and can be used as is. When 
loading a job onto a device, you are prompted to adjust the camera 
definition if the device is different from the one the job was created on. 
Warnings that require user action are shown if the I/O assignments are 
out of range for the device or if the job uses IntelliFind but is loaded on a 
device that does not support this tool.

Creating jobs for these Systems is the same as creating jobs for other 
physical devices with the following differences:

• No specific camera definitions for a specific device are programmed 
into the VisionSystemStep camera channels. The default for Software 
Systems is Sentech A33. You must change the camera definition in 
the VisionSystemStep properties page if a different (usually) image 
size is required, or if your are working offline and plan to load the job 
later on a physical device.

• By default, the Acquire Tool is programmed to Load Images from File, 
as there is no digitizer available on a Software System (Image List is 
empty originally and must be populated also). When loaded on a 
physical device, you must change the Acquire mode to Acquire from 
Camera to enable acquisition from the device CCD sensor.

For complete information about the Acquire and the Vision System step, 
see Chapter 1 of the Visionscape Tools Reference
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Displaying I/O Transitions
The I/O Display (Figure 2–9) watches I/O transitions for Physical I/O, 
Sensors, Strobes, and all 2048 Virtual I/O points. You can also use the 
green Click to record transitions to a DSS file button to record transitions 
over time to a DSS file and examine the transitions using the Digital Soft 
Scope tool (see “Examining I/O Transitions (Digital Soft Scope)” on 
page 2-22). You can select the Vision System in the list at the top, then 
connect or disconnect the display using the green Connection button. I/O 
states are updated in the display as they occur. When an I/O point is 
asserted, the button turns red. You can also click the button to toggle the 
I/O point. For GPIO points programmed as inputs as well as for Sensors, 
clicking the button has no effect. You can display 128 points of the Virtual 
I/O at one time. Use the Range: list box to select the points you want to 
display.
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Simulating Triggers

Note: For more information about triggers with smart cameras, see the 
Advanced Triggering Techniques section in Chapter 1 of the Visionscape 
Tools Reference.

FrontRunner allows you to simulate a trigger in a job for diagnostic 
purposes.

Use the following procedure to simulate a trigger:

1. Create a new job or open an existing job.

2. Click Editor to display the Editor window.

3. In the left pane, select Acquire.

Note: You may have to click the Acquire tab.

4. In the right pane, click to the right of the Trigger property.

5. From the leftmost pull-down menu, select Virtual Point.

6. To the right of Virtual Point, select a number. For example, 0001.

7. Close the Editor window.

8. Click the I/O button.

FrontRunner displays the I/O Display window, as shown in 
Figure 2–9.
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FIGURE 2–9. I/O Display Window

9. In the I/O Display window, select your smart camera.

10. Click Connect/Disconnect.

Note: When the Connect/Disconnect button is green, you are 
connected.

11. Select the Virtual I/O trigger (lower right hand side of screen) you 
selected previously in the Acquire properties page.

12. By default, the Trigger Interval is 500 ms.

13. In the FrontRunner window, click Settings.

Select a Device

Connect/Disconnect

Start Triggers

Click to record transitions in a DSS file
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FrontRunner displays the Settings dialog box.

14. In the Settings dialog box, click to select Use I/O During Tryout and 
Use Triggers During Tryout.

15. Close the Settings dialog box.

16. Download the job to the smart camera.

17. Start the job.

18. In the I/O display window, click Start Triggers.

Important Note
When using Virtual I/O points to generate triggers at regular interval, as 
programmed in the Visionscape IO Display or the FrontRunner RunView 
IO bar the accuracy of the timing between triggers will depend on the 
Operating System the avp runs on and also on the number of Virtual I/O 
points programmed to be triggers. The following information provide 
guidelines based on Device/OS configurations:

• GigE Cameras and Software Systems — Triggers generated by the 
avp, IO display and FrontRunner IO bar.

– Windows XP — Accuracy +/- 5 msec typical, trigger to trigger 
time increases as more triggers are generated. 

– Windows 2000 — Accuracy +/- 25 msec typical, trigger to trigger 
time increases as more triggers are generated.

Note: The values above are typical and may vary from PC to PC. 
Accuracy should be measured/tested first for the particular avp for the 
particular PC. When greater accuracy than the Device allows is required, 
physical triggers should be used instead.
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Examining I/O Transitions (Digital Soft Scope)
Digital Soft Scope examines I/O transitions recorded in a DSS file:

1. From the FrontRunner View menu, click Digital Soft Scope.

2. From the DSS File menu, select Open.

3. Select a DSS file (*.dss) and click Open.

A window similar to the one in Figure 2–10 is displayed:

FIGURE 2–10. Digital Soft Scope Main Window

The resulting signal trace can be viewed graphically as a timing 
diagram useful for analyzing I/O timing and interaction.

To modify the time slice of the trace view, adjust the slider bar located 
at the top left. This changes the number of seconds per division in the 
view. Adjusting the Current View slider bar to the right scrolls the view 
window to display the signals in different time segments. The time 
segment and the total time of the recorded signals are displayed 
above this slider. A summary of transitions, or trace statistics, of each 
signal can be obtained by clicking on the name of that signal in the 
signal list. Clicking the right mouse button provides additional 
capabilities including time measurement, zooming, redrawing, and 
removal of signals. Once a signal is removed, you can add it to the 
trace again by clicking on that signal name in the signal list.
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One of the most useful features of the Digital Soft Scope tool is the 
ability to measure signal lengths and time between transitions. A click 
in the signal window enables the measuring tool, which appears as a 
pair of white dotted lines that can be moved independently. When the 
lines are positioned, the time difference represented by the distance 
between them is displayed at the bottom of the main window. This 
time is continuously adjusted as the tools move.

Camera Calibration
For complete information about calibrating your camera, see Chapter 3, 
“Camera Calibration”.

The Part Queue
For complete information about the Part Queue, see Chapter 4, “The Part 
Queue”.
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Windows You’ll See in FrontRunner

The Main FrontRunner Window

FIGURE 2–11. Main FrontRunner Window

This is the main FrontRunner window. Take a couple of moments to 
familiarize yourself with it. Notice the following:

• Device Buttons — This area contains device buttons for Software 
Systems, Visionscape GigE Cameras, and smart cameras on the 
network:

– You can add and delete buttons for Software Systems:

Note: You can start the AvpBackplane directly by selecting 
Start > Visionscape > Visionscape Backplane.

To add a Software System button, first start and then exit 
FrontRunner. Right click on the VS tray icon. Click Display 
AvpBackplane. The Visionscape AvpBackplane dialog box is 
displayed. Click Add. Type in a name for the Software System 
and click OK. When you restart FrontRunner, the Software 
System button will be displayed in the Device Button area of 
FrontRunner (Figure 2–11).

To delete a Software System button, right click on the VS tray 
icon. Click Display AvpBackplane. The Visionscape 

Device Buttons

Device Bar

Toolbar

Software System button

Smart Camera button



Windows You’ll See in FrontRunner

F
ro

n
tR

u
n

n
er

2

Visionscape FrontRunner User Manual 2-25

AvpBackplane dialog box is displayed. Highlight the name of the 
Software System you want to delete. Click Remove, then Yes, 
and finally OK.

– You cannot add or delete buttons for the vision GigE Camera; this 
is done automatically.

– You can add and delete smart camera buttons. To add a smart 
camera button, click Add Button. FrontRunner displays the Select 
Device dialog box. Highlight (to select) a smart camera, and click 
OK. FrontRunner adds the button.

Note: A red diskette in a device button indicates that the current job 
on the device has been changed through editing.

• Device Bar — This area contains icons and messages that display 
information about devices to which you are connected:

–  <no device selected>

–  <device> Live Video

–  <device> Editing

–  <device> Tryout Mode

–  <device> Running

–  <device> Stopped

–  FrontRunner is performing some operation (please wait)

• Toolbar — This dynamic toolbar contains icons for FrontRunner tools.
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The Setup Window
FrontRunner displays the Setup window after you click Create New 
Program or Open Existing Program. This is where you set up the focus 
and lighting, etc., for the camera before you acquire a new image. Take a 
couple of moments to familiarize yourself with the window.

FIGURE 2–12. Setup Window

Notice the button for the smart camera. This icon indicates the following:

• The yellow background indicates that you have control of the smart 
camera

Job List

Image Display Area

Properties Context
Menu
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• The pencil indicates that the job on the PC is being edited

• The red diskette indicates that the current job on the device has been 
changed through editing

• The padlock indicates to users on the network that the smart camera 
is controlled

Setup Window Toolbar Buttons
The Setup Window Toolbar buttons are shown in Figure 2–13:

FIGURE 2–13. Setup Window Toolbar Buttons

• Create New Program — After you click this button, FrontRunner 
displays the Setup window.

Create New Program
Open Existing Program

Save Program

Save Program on Device to Flash

Upload Program from Device to PC

Download Program from PC to Device

Start Program on Device

Stop Program on Device

Train Selected Step

Untrain Selected Step

Run Current Step then Jump to Next Step

Jump to Previous Step

Try Out Program on PC in a Loop

Try Out Program on PC Once and Then Stop

Try Out Current Step on PC

Acquire New Image

Live Video

Settings

Zoom Buttons

Autocalibrate

Perform White Balance Calibration

Restore Pre-Set White Balance
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• Open Existing Program — Opens a job that was previously saved to disk.

• Save Program — Saves the current job to disk on the PC. If the job 
already resides on disk, FrontRunner will simply save the job without 
displaying the Save Job dialog box. If you want to save the current job 
with a different name, select File > Save Job As. In the File name text 
box, type a different name for the job you want to save, and then click 
Save.

Note: If the current job changes through editing, the Save button is red.

• Save Program on Device to Flash Memory — Saves the current job 
on the camera to Non-Volatile memory. You can only flash the smart 
camera when it is stopped. This operation takes some time.

Note: Do not perform Save Program on Device to Flash Memory 
often (as a replacement for job changeover, for example).

• Upload Program from Device to PC — Uploads the current job on the 
camera to the PC.

• Download Program from PC to Device — Downloads the current job 
from the PC to the camera.

• Autocalibrate — Configures the camera’s focus, exposure, and gain.

• Perform White Balance Calibration (Color Cameras Only) — 
Equalizes color channel gain such that white objects appear white.

• Restore Pre-Set White Balance (Color Cameras Only) — Returns 
color channel gain to factory preset.

• Start Program on Device / Stop Program on Device — Use these 
buttons to start and stop the current job.

• Train Selected Step — Some tools (like the Barcode Tool and the 
Data Matrix Tool) can be trained. When you train a tool, you are 
“telling” the tool what to expect when it reads an image. For example, 
if you train the Data Matrix tool to read a Data Matrix with 12 rows and 
12 columns, the Data Matrix tool will fail when it encounters a Data 
Matrix with 16 rows and 16 columns. You will know a tool needs to be 
trained when you see:

– A red x to the left of the tool name

– The red Train button

• Untrain Selected Step — Just as some tools (Barcode and Data 
Matrix) need to be trained, those same tools may need to be 
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untrained when you want them to read a part that differs from the part 
they have been reading. For example, if you train a Data Matrix tool to 
read a Data Matrix with 8 rows and 32 columns, it will not read a Data 
Matrix with 16 rows and 16 columns until you untrain the tool. Use the 
following procedure to untrain a Data Matrix tool:

a. Highlight the Data Matrix tool in the left window pane.

b. Click Untrain. Now, you can train the tool to read a new part, or 
leave it “opened up” to read any Data Matrix.

• Run Current Step then Jump to Next Step / Jump to Previous Step — 
Use these buttons to walk through the Setup List and train/execute 
each trainable tool.

• Try Out Program on PC in a Loop — Runs the job on the PC until you 
click this button again.

• Try Out Program on PC Once and Then Stop — Runs the job on the 
PC once and then stops.

• Try Out Current Step on PC — Runs the current step on the PC.

• Acquire New Image — Acquires a new image.

• Live Video — Allows you to see exactly what the camera is seeing in 
real time. This makes it easier for you to adjust focus and lighting to 
get the best image possible.

Note: If the camera acquisition is triggered in the avp, Live Video will 
be triggered also. This behavior can be turned off in Tryout mode only 
from the Tryout Options dialog box in the case where triggers cannot 
be fed to the system during Live Video.

• Zoom In — Makes the image larger.

• Zoom Out — Makes the image smaller.

• Zoom To Fit Window — Sizes the image to fit the window.

• Zoom 1:1 — Displays the image in its actual size.

• Settings — Contains the following tabs:
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– Edit — FrontRunner allows you to specify what action(s) will take 
place after you change a step or during tryout.

• Automatic Run Step after Change — When checked, 
FrontRunner automatically runs the step after a change is 
made to its ROI or properties. By default, this is checked.

• Acquire Images During Tryout — In Tryout mode, when this 
option is checked, FrontRunner loads each image that you 
specified in the Acquire step, one at a time. If you uncheck 
this option, and click Try Out Program on PC Once and Then 
Stop repeatedly, your job will run on only the image that is 
loaded currently.

• Use I/O During Tryout — Enables/disables I/O during tryout.

• Use Triggers During Tryout — Enables/disables triggers 
when running a tryout.

• Automatic Train Step after Change — When checked, 
FrontRunner automatically trains (when appropriate) the step 
after a tool is inserted, moved, or resized.

• Delay Between Steps in Tryout — When checked, 
FrontRunner slows down the “action” by adding a delay 
between each tool so that you can see specific tool activity.

• Show Properties — Allows you to specify where a tool’s 
properties page is displayed in Tryout View:

– Hide

– Below View (default)

– Right of View

– Timing — FrontRunner allows you to enable or disable (default) 
the uploading of timing data. To enable step timing:

a. Create a new job or load an existing job onto your PC.
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b. Click on the Settings button:

c. In the Settings dialog box, click the Timing tab, and then click 
on the Enable Step Timing check box.

d. Close the Settings dialog box.

e. Try Out your job by clicking Try Out Program on PC in a 
Loop:

f. Click the Reports button to display the Statistics and Results 
window. Notice that FrontRunner has added the Show Timing 
Report button to the Statistics and Results window. Click the 
Show Timing Report button to display the Timing Report:

Settings

Try Out Program on PC in a Loop

Show Timing Report



Chapter 2 FrontRunner

2-32 Visionscape FrontRunner User Manual

• Windows Toolbar — This toolbar is displayed only when you are 
connected to a device that is stopped and a job is loaded into 
FrontRunner for editing. This area contains buttons for the following tools:

–  Editor

–  Reports

–  Calibration

–  I/O 

–  Network 
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The Context Menu
To display the context menu, right click on the image display area.

FIGURE 2–14. Context Menu

• Insert Step Into Snapshot... — Opens up the Insert Tool Dialog Box 
into the Snapshot tool. The tool position will be defaulted towards the 
top-left of the image with size 100x100.

Note: If this menu option is selected while the mouse is inside a tool 
in the Image, a new menu entry is available: “Insert Step into <current 
tool>...”.

• Peg Image — In Try Out in a Loop or Try Once “pegs” the image 
currently being displayed so that any sub-image of other tools are not 
displayed in succession while the avp runs.
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• Maximize ROI — Makes the current Step ROI be the size of the 
image it is in.

• Train — Same as the Toolbar Button Training Hat if the selected tool 
(i.e., ROI) is a trainable tool.

• Delete — Same as Step Editor Delete button for the currently 
selected tool (i.e., by its ROI).

Note: Not all tools can be deleted this way as some tools in the avp 
have no ROI and are not visible in the image.,

• Show Point Numbering — Number the vertices of the ROI. Clicking 
on these special points allows the ROI shape to be changed; clicking 
elsewhere simply moves the ROI.

• Show Tools — Hide all the Tools ROIs so that the image (with results 
graphics if the tools have run) can be seen without their clutter 
underneath.

• Show Overlay — If Custom VB code has written in the overlay for this 
image, these additional typically non-tool graphics can be hidden or 
shown on the image.

• Shape > Hide Current Shape — Add the current Tool ROI. This tool 
ROI can no longer be selected or changed.

Note: More than one ROI can be hidden this way.

• Shape > Show All — Restore all the ROIs so that they all appear 
again and can be edited with the mouse.           

• Shape > Zoom To Shape — Zooms the image such that the selected 
ROI occupies the entire viewing area.

• Refresh View — Repaints the current image (including graphics).
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• Acquire Live — Same as LiveVideo button in toolbar.

• Regenerate — If the image being displayed on the screen is the 
output of an Image Processing tool (i.e., Morphology, Sobel, etc.), 
then Regenerate takes a new Picture and runs the Image Processing 
tool to show the resulting output image.

• Save Image... — Saves the current Image in TIFF format with no 
graphics to disk. You are prompted for a file name and location.

• Zoom In — Makes the image larger.

• Zoom Out — Makes the image smaller.

• Zoom To Fit Window — Sizes the image to fit the window.

• Zoom 1:1 — Displays the image in its actual size.

Saving an Image
Right click on the image you want to save. In the Context menu, select 
Save Image... to save the current image to the PC. When the Save As 
dialog box is displayed, enter a name for the image you are saving.
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The Editor Window
FrontRunner displays the Editor window after you click Editor. This is 
where you adjust properties for a step or tool. Take a couple of moments 
to familiarize yourself with the window.

FIGURE 2–15. Editor Window

Job Properties for
Inspection Step
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Editor Window Toolbar Buttons
The Editor window contains the following buttons:

FIGURE 2–16. Editor Window Buttons

• Insert a tool (into, before, after) the currently selected Step — After 
you click one of these buttons, FrontRunner displays the Insert Step 
dialog box. Highlight the tool you want to insert and click OK. 
FrontRunner inserts the tool into the job.

• Delete the currently selected Step — FrontRunner deletes the 
currently selected step. FrontRunner will display a dialog box to which 
you must respond. Click Yes to delete the selected step; otherwise, 
click No.

• Cut — FrontRunner cuts the currently selected step. FrontRunner will 
display the Delete Step dialog box. To cut the selected step, click OK; 
otherwise, click Cancel.

• Copy — FrontRunner copies the currently selected step.

• Paste — FrontRunner pastes the currently selected step. The drop 
down menu contains the following items:

– Paste Into

– Paste Before

– Paste After

• Job View — Displays all the Vision System Steps you have loaded.

• Part Tree View — Displays advanced parameters for calibration.

Part Tree View
Job View

Paste

Copy
Cut

Inset a tool after the currently selected Step
Inset a tool before the currently selected Step

Inset a tool into the currently selected Step

Delete the currently selected Step
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The Reports Window

FIGURE 2–17. Reports Window

This window displays the results that you selected for upload in the 
Inspection Step’s Select Results to Upload datum. It displays inspection 
counts, overruns, and memory statistics. The Reports window contains 
the following buttons:

FIGURE 2–18. Statistics and Report Window Buttons

Display extended results

Show results in World (calibrated) space

Show all statistics in World (calibrated) space

Reset all counters and statistics

Reset inspection counters

Reset all statistics

Copy result data to Clipboard
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Button Descriptions

• Display Extended Results — This LED turns green if the inspection 
passed, and red if the inspection failed.

• Show results in World (calibrated) space — Shows results in a world 
coordinate versus a pixel coordinate system.

• Show all statistics in World (calibrated) space — Shows statistics in a 
world coordinate versus a pixel coordinate system.

• Reset all counters and statistics — Resets both the counters and the 
statistics to zero.

• Reset inspection counters — Resets only the counters to zero.

• Reset all statistics — Resets only the statistics to zero.

• Copy result data to Clipboard — Copies the data to the Clipboard as 
tab-delimited text.

Statistics

• Cycle Counts — Displays the total number of inspection cycles so far, 
as well as the number of passed and failed inspections. The “PartQ” 
column is only relevant if you have activated the Part Queue (see 
Chapter 4, “The Part Queue”) in your inspection. It displays the 
current number of entries in the Queue, and the maximum size of the 
Queue. So, if you’ve set the size of the Queue to be 20, and there are 
currently 5 entries in it, then “5/20” is displayed. 

• Timing — Displays timing information on the last inspection cycle. All 
times are in milliseconds.

– Cycle — Time between triggers.

– Cycle Worst — Worst time between triggers.

– Process — Actual time spent processing the image. This will not 
include image acquisition time in a standard triggered job.

– Draw — Time spent rendering graphics.

– PPM — Number of parts per minute.

– PPM Worst — Worst number of parts per minute.
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– Idle — Amount of time within the cycle during which the 
inspection was doing nothing. When your Idle time is at or very 
close to 0, that is telling you that you are getting close to 
overrunning.

• Overruns — The total number of overruns that have occurred so far.

Results Section

FIGURE 2–19. Results

The results that you select for upload are displayed here. The name of the 
Step and datum are displayed in the left-most column, and the actual 
result data is displayed in the columns to the right. Most results in 
Visionscape are returned as either a single value (a distance, a tool 
status, the number of blobs, etc.), or as a one-dimensional array (a point, 
a line, etc.). These values are displayed immediately in the dialog. Some 
results are returned as two-dimensional arrays. We refer to these as 
“Complex Datums”. When a Complex Datum is in the result list, we will 
not attempt to display its results every time. However, in the column 
labeled with a “C” (for Complex) you will see an arrow icon displayed. In 
the example above, you will notice the blue arrow next to the Data Matrix 
Tool’s SymResults datum, and the Blob Tool’s “Blob Tree” datum. If you 
wish to view the data for a complex result, simply click on the arrow, and it 
will expand the grid to show you the data.
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The I/O Display Window

FIGURE 2–20. I/O Display Window

This window watches I/O transitions for Physical I/O, Sensors, Strobes, 
and all 2048 Virtual I/O points. You can also use the green Click to record 
transitions to a DSS file button to record transitions over time to a DSS file 
and examine the transitions using the Digital Soft Scope tool. You can 
select the Vision System in the list at the top, then connect or disconnect 
the display using the green Connection button. I/O states are updated in 
the display as they occur. When an I/O point is asserted, the button turns 
red. You can also click the button to toggle the I/O point. For GPIO points 
programmed as inputs as well as for Sensors, clicking the button has no 
effect. You can display 128 points of the Virtual I/O at one time. Use the 
Range: list box to select the points you want to display.

When using Virtual I/O points to generate triggers at regular interval, as 
programmed in the Visionscape IO Display or the FrontRunner RunView 
IO bar or from within the avp itself with an IO Inspection, the accuracy of 
the timing between triggers will depend on the Operating System the avp 
runs on and also on the number of Virtual I/O points programmed to be 
triggers. The following information provides guidelines based on 
Device/OS configurations:
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• Smart Cameras — Accuracy < 1 msec, independent of the number of 
virtual triggers generated by the avp. Trigger to trigger time depends 
on relative priority of Inspection. 

• GigE Camera and Software Systems — Triggers generated by the 
avp, IO display and FrontRunner IO bar. 

– Windows XP — Accuracy +/- 5 msec typical, trigger to trigger 
time increases as more triggers are generated. 

– Windows 2000 — Accuracy +/- 25 msec typical, trigger to trigger 
time increases as more triggers are generated.

Note: The values above are typical and may vary from PC to PC. 
Accuracy should be measured/tested first for the particular avp for the 
particular PC. When greater accuracy than the Device allows is required, 
use physical triggers.
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The Network Overview Window
You can display the Network Overview window in either of the following ways:

• From FrontRunner, select View > Network Overview.

• From the deskstop, select Start > Programs > Microscan Visionscape 
> Tools > Visionscape Network Browser.

The Network Overview window lists PC adapters and smart cameras on 
the network that the client PC can reach.

• Black text in the Name indicates that the client PC can reach a smart 
camera and connect to it.

• Red text in the Name indicates that the client PC can reach a smart 
camera but cannot connect to it. Such a device is on the same 
physical network as the client but its IP settings ( IP address and 
network mask) are incompatible with the client PC, preventing any 
point-to-point TCP communication link.

• You can adjust the width of columns (one at a time).

• You can sort data by clicking on a column heading.

Click to display
more info

Click to display
less info
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The Network Overview window displays information about GigE Cameras 
and smart cameras on the network (notice the < and >):

• Model — Is one of the following:

– Smart Camera (can only monitor; jobs cannot be downloaded 
using Visionscape 8.x.)

– Smart Camera standard resolution

– Smart Camera high resolution

– Smart Camera standard resolution with IntelliFind

– Smart Camera high resolution with IntelliFind

• Name — The name of the smart camera

• IP Address — The IP address of the smart camera

• DHCP — Is either of the following:

– Y — The smart camera is using dynamic IP addressing

– N — The smart camera is using static IP addressing

• Status — The status of the smart camera

• Controller — The IP address of the PC that is controlling the smart 
camera

• Job — The name of the job that is loaded on the smart camera

Note: For the job name to be displayed in the Network Overview 
window, you must first save the job to disk, then download it to the 
smart camera.

• Cycles — The total number of cycles

• Passed — The number of cycles that passed

• Failed — The number of cycles that failed

• Alarms — The total number of alarms

• Connections — The number of connections to the smart camera

• SW Version — The version of the software running on the smart 
camera

• Subnet Mask — The subnet mask of the smart camera

• MAC Address — The MAC address of the smart camera
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Changing a Camera’s Name

Note: You will need the user name and password for the camera whose 
name you want to change.

From the Network Overview window, you can change the name of the 
smart camera over Ethernet without a serial connection and 
HyperTerminal. This change is dynamic and does not require you to 
reboot the smart camera.

Use the following procedure to change the camera name:

1. Select View > Network Overview.

FrontRunner displays the Network Overview window.

2. Click on the name of the camera whose name you want to change.

FrontRunner displays the Change Network Settings button.
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3. Click Change Network Settings.

FrontRunner displays the Camera is Selected dialog box.

4. Click Yes.

5. Enter a user name.

FrontRunner displays the Change Network Settings dialog box.

6. Double click (to highlight and select) the original camera name.

7. Type in a new name for the camera.

8. Click OK.

FrontRunner changes the original camera name to the new camera 
name.

Changing a Camera’s IP Settings

Note: You will need the user name and password for the camera whose 
IP settings you want to change.

From the Network Overview window, you can change the IP Settings 
(Static IP or DHCP) of the smart camera over Ethernet without a serial 
connection and HyperTerminal. After the changes, the smart camera will 
reboot automatically.

Use the following procedure to change the IP settings:

1. Select View > Network Overview.

FrontRunner displays the Network Overview window.

2. Click Change Network Settings.

FrontRunner displays the Change Network Settings dialog box.
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3. Do either of the following:

a. If a DHCP server is available on the same physical network as 
the device, then select Obtain an IP address automatically.

Note: The smart camera may take up to one minute to acquire a 
new IP address.

b. If no DHCP server is available, select Use the following IP 
address, and fill in the IP address and Subnet mask for the 
device.

Note: Make sure the IP address and Subnet mask are compatible 
with one of the adapters in the PC.

4. Click OK.

FrontRunner displays the “Login to device” dialog box.

5. Enter the user name and password for the camera.

6. Click OK.

The smart camera reboots automatically, and the changes take effect.

Changing a Camera’s Password

Note: You’ll need the user name and password for the camera whose 
password you want to change.

Use the following procedure to change a camera’s password:

1. Start FrontRunner by clicking Start > Visionscape > Visionscape 
FrontRunner.

2. Click on the name of the camera whose password you want to 
change.

3. Click Take Control.

FrontRunner displays the Login to Device dialog box.

4. Enter the user name for the camera.

5. Click OK.
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Notice that the Take Control button changes color and becomes the 
Release button.

6. Right click on the Release button and highlight Change User ID and 
Password.

FrontRunner displays the Change User Name and Password dialog 
box.

7. In the Password text box, type the new password for the camera

8. In the Confirm Password text box, re-type the new password for the 
camera.

9. Click OK.

The camera’s password has been changed.
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Menus You’ll See in FrontRunner

File Menu
The File menu contains the following menu items:

• New Job — Displays the Setup window.

• Open Job — Opens a job that was previously saved to disk.

• Close Job — Closes the current job.

• Upload Job — Uploads the current job on the camera to the PC.

• Save Job — Saves the current job to disk on the PC. If the job already 
resides on disk, FrontRunner will simply save the job without 
displaying the Save Job dialog box. If you want to save the current job 
with a different name, select File > Save Job As. In the File name text 
box, type a different name for the job you want to save, and then click 
Save.

• Save Job As — Allows you to save the current job to disk on the PC 
and give the job another name. FrontRunner displays the Save As 
dialog box. Specify a name and click Save.

• Dump Job to Text File — Creates a text file containing a listing of 
each loaded Vision System. After you select this menu item, 
FrontRunner displays the Save Vision System Tree as Text dialog 
box. Specify a name for the text file and click Save.

• Show Job Info — Displays the header information for a job:

– Job name

– Version of the software used to create the job

– Total objects

– Total steps

– File type

– Digitizer type
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• Configure Device — Displays a dialog box containing tabs for the 
following:

– Serial Ports — The COM ports are indexed to the target 
platform’s available UARTs. The default is NONE, which will 
construct the output string datum but not transmit the result on 
any port.

After you select Configure Device, FrontRunner displays the 
Configure dialog box. Configure the various parameters, then 
click Apply and then OK.

Note: For smart cameras, the serial ports are named RS232-
<Number>. For example, the smart camera single serial port is 
called RS232-1.

– TCP Ports — The TCP ports are indexed according to the port 
settings specified in the Configure Device dialog box. For 
example, if Starting Serial TCP Port is 49211, then selecting 
TCP1 will output on port 49211, TCP2 on port 49212, etc. The 
default is NONE, which will construct the output string datum but 
not transmit the result on any port.

After you select Configure Device, FrontRunner displays the 
Configure dialog box. Click the TCP Ports tab. Type in the 
appropriate information, then click Apply and then OK.

Range: 2000 - 5000 and 49210 - 49500

• Options — Displays a dialog box containing tabs for the following:

– Runtime

• PC Runtime Priority — This setting is used when 
FrontRunner is running a vision application. When the 
application starts, the runtime priority of the process is 
changed using this setting. The options are “Normal”, “High”, 
and “Realtime”.

Note: You must be logged into an account that has access 
rights to change the process setting accordingly. By default, 
only Administrators and Power Users have this right. It can 
be changed for Windows XP in the Control Panel > 
Administrative Tools > Local Security Policy console. In the 
console, select the Local Policies group, and then User 
Rights Assignments. You’ll need to add your user account to 
the “Increase scheduling priority” setting if you are not 
running as an Administrator.
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– Reports — From this page, you can set the start-up options for 
the report and decimal accuracy:

• Number of x decimal places — Use this option to set the 
decimal accuracy of floating-point values in the report. The 
default is 3 for pixel decimal places; the default is 5 for world 
decimal places.

• Use Calibrated Space when activated — When this option is 
checked and the report is activated, by default, the report will 
use calibrated space. Otherwise, values are shown in the 
report in pixel space when the report is started.

View Menu
The View menu contains the following menu items:

• Network Overview — Displays the Network Overview window, which 
displays critical information about smart cameras on the network. See 
“The Network Overview Window”.

• Part Queue — Displays the Part Queue application, which maintains 
a Queue of the last n cycle images and results. You decide how large 
the queue will be and whether it stores results and images for every 
part, or just for passed parts, or just for failed parts. If you activate the 
Queue, the Part Queue Viewer allows you to upload it, and view any 
of the images and results that were stored on the device at runtime. 
For complete information about the Part Queue, see Chapter 4, “The 
Part Queue”.

• Debug Output — Displays output messages from Perl scripts and 
internal messages from the Visionscape Framework and from 
FrontRunner.
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FIGURE 2–21. Debug Window

– Clear the display — Clears the Debug Output window.

– When important messages are added to the display, show this 
window — Automatically displays important messages when they 
are added to the window.

– Set the debug level — Allows you to set the importance of a 
message:

• None (default)

• Level x, where x is a value (1 - 6)

– Log all messages to — Starts/Stops active logging of debug 
messages.

Note: Active logging of debug messages can affect Visionscape’s 
ability to process jobs.

– Copy contents of Debug Window to Clipboard — Copies the 
contents to the Clipboard as tab-delimited text.

• I/O Display — See “The I/O Display Window”.

• Digital Soft Scope — Examines I/O transitions recorded in a DSS file. 
The resulting signal trace can be viewed graphically as a timing 
diagram useful for analyzing I/O timing and interaction. For more 
information, see “Examining I/O Transitions (Digital Soft Scope)”.

Clear the display

When important messages are added to the display
show this window

Set the debug level

Log all messages to 

Copy contents of Debug Window to Clipboard
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• Display Tools — Contains the following items:

– Threshold Helper — Examines the effects of threshold settings on 
the current image using the Threshold Display Toolbar 
(Figure 2–22).

FIGURE 2–22. Threshold Display Toolbar

When activated, the current image is displayed using a threshold 
color scheme determined by the settings in the toolbar. You can use a 
single or dual threshold, and show colors or gray-scales below, 
between, or above the thresholds using the buttons in the Color 
Display options. The threshold(s) are displayed in the toolbar along 
with sliders. You can type in the thresholds directly or use the sliders 
to change the current values. The linear effect of the thresholds is 
displayed at the bottom in the appropriate colors. This can be used as 
a “key” to decipher the image display.

When a tool that has thresholds is selected and the toolbar is used, 
the thresholds in the tool are automatically updated and the tool is re-
executed when you release the slider.

Note: If the tool has auto-threshold capabilities, then the tool is not 
updated and is not executed. This is because the auto-threshold in the 
tool will override any manual settings.

– Mask Tools — Using this floating toolbar, you can select different 
drawing tools to draw a mask in the ROI of a mask-oriented tool.

You can enable the mask capability of an appropriate tool by selecting 
the tool in the Step Tree. The Lightbulb button in the Masking Toolbar 
is enabled. When you click it, it “lights up”, enabling the mask in the 
tool and enabling the drawing tool buttons of the toolbar. You can then 
select any of the drawing tools, and draw the mask using the mouse 
or select the “pointer” to return to standard tool selection/insertion 
with the mouse.

• Fill ROI — Fills the entire ROI of the masked tool.

• Clear ROI — Erases the entire ROI of the masked tool.

Show Below
Show Between
Show Above

Dual Threshold
When Depressed;
Otherwise, Single
Threshold
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Help Menu

The Help menu contains the following menu items:

• Visionscape ReadMe File — Click on this menu item to open the 
Visionscape ReadMe.

• Visionscape FrontRunner User Manual — Click on this menu item 
to open the Visionscape FrontRunner User Manual.

• Visionscape Tools Reference — Click on this menu item to open 
the Visionscape Tools Reference Manual.

• Getting Started with Visionscape GigE Cameras — Click on this 
menu item to open Getting Started with Visionscape GigE Cameras.

• Visionscape Tutorials and Samples — Click on this menu item to 
display tutorials and sample jobs.

• About Visionscape FrontRunner — Displays the FrontRunner 
Version, and Build number. Click OK to close the window.
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Color Image Display Options

Color Image File Name Format
When you save a color image in FrontRunner, two .tif images are saved. 
One is in the file name format <file name>.tif. and the other is in the file 
name format <file name>-rawbayerdata.tif. 

For example, a file called “colortest” would be saved in the formats 
colortest.tif and colortest-rawbayerdata.tif.

If you wish to run a job from a stored color image, you must select the file whose 
name is in the format <file name>-rawbayerdata.tif and not <file name>.tif.

Color Image Display in FrontRunner
The Snapshot step shows the color image as acquired from the camera. 
The buffer manager control in FrontRunner shows both the RGB and HSI 
(red = 0) values under the cursor if the image acquired is a color image. 
Zooming fully into the image will show the individual RGB values for each 
pixel of a color image.

FIGURE 2–23. Color Buffer Display of Zoomed Image
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Running Color Plane Selection

When displaying images from a color camera, the upper right of the 
image display includes the text of the current image plane displayed. The 
default is the RGB color image. Channel selection will be limited to those 
channels used by vision tools that are inserted in the current Snapshot.

FIGURE 2–24. Runtime Displaying Color Image
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When you click RGB Color a dropdown menu will appear, allowing you to 
select from the image channels used in the job.

FIGURE 2–25. Runtime Image Channel Selection Dialog
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In the following example, the user has selected the Intensity image 
channel. At this point, the software will now display that channel.

FIGURE 2–26. Runtime Display of Intensity Channel
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Finally, if you click the magnifying glass icon to zoom the image, the name 
of the image channel zoomed will appear in the image status bar next to 
the pixel value and location.

FIGURE 2–27. Zoom Options with Color Runtime Display

Note: You can select what image channel to display but ALL the enabled 
graphics for the job will be displayed regardless of which plane they are 
running in.
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Color Perl Scripts
Color versions of Microscan cameras are supported by Visionscape 
FrontRunner. All FrontRunner tools can be used in different color planes.

Specific color-related functionality is available in the form of custom scripts. 

A set of Perl scripts is provided with the Visionscape installation that can 
perform analysis of color images. The scripts are automatically available 
in Visionscape and can be inserted into a job by navigating to the Script 
tab in the Insert Step dialog and selecting Custom Vision Tool. 

Then, from the Custom Vision Tool Input datums, select the desired script 
by clicking the Available Package Script:
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The tool will then be available:
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ColorTrain and ColorID
These scripts are used together to train a library of colors and then check for those 
specific colors at runtime.

ColorTrain

Purpose: Allows you to create libraries of trained colors.

Use:

• Drag and size the ROI over a solid color area that you wish to train.

• Select the “Color Library Name” datum and enter the name of an existing color library, or 
the name you wish to use for a new color library. If you want to create a new color 
library, check the “Create New File” datum.  

Note: Color Libraries are always saved in the \Microscan\Visionscape\Jobs\Fonts 
folder with the extension OCL.

• To train a new color, enter the name of the color in the “Name for New Color” datum. 
Now train the Step, and your new color will be added.

• Check the “Draw Trained Colors” datum, and all trained colors will be drawn in the upper 
left corner of the image.

• Check the “Lock Library” datum if wish to prevent any more colors from being trained.
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The ColorTrain tool has the following input and output parameters:

Training is done by positioning the ROI (region of interest) around the color area, entering 
a name for the new color, and clicking the Train button. This is an example of the

ColorTrain Tool Setup and Inspection:
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ColorID

Purpose: Attempts to identify a color by comparing the pixels within its ROI to the trained 
colors in a specified color library.

Use:

• Select the color library that will be used by the Step by specifying its name in the “Color 
Library Name” datum. If you have not created any color libraries, refer to the previous 
section on the ColorTrain script for a description of how to create one.

• The Step inspects the average color value within its ROI, and compare it to various 
colors trained in the library. The name and index of the closest color match will be output 
by the tool.  

• The “Color Distance Threshold” can be used to specify how close a color must be to the 
trained value in order to be considered a match.  Decrease this value to require a closer 
match, increase the value to allow a looser match.

• The Step can be made to check for a specific color, such that it will pass if the color is 
detected, and fail if any other color is detected.  Check the “Color Match” datum to 
activate this mode, and then enter the name of the color to check for in the “Match to 
Color” datum.

• Check the “Show Graphics” datum if you want the name of the detected color to be 
drawn in the image at runtime.



Color Perl Scripts

F
ro

n
tR

u
n

n
er

2

Visionscape FrontRunner User Manual 2-65

The ColorID tool has the following input and output parameters:

ColorID Tool During an Inspection:
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ColorSpotCheck

Purpose: Allows you to train on a single color in RGB or HSI. The Step will then pass only if 
the same color in RGB or HSI is detected in future images.

Use:

• Position the inner, smaller ROI of the Step over the color you wish to train on, and hit the 
Train button. The average Red, Green, and Blue values and Hue Saturation and 
Intensity values, within the ROI will be trained and stored in the Tool.

• Position the outer, larger ROI over the pixels to be inspected at runtime. During each 
cycle, the Step will pass if the average color value of the pixels within the larger ROI 
roughly matches the trained color. Otherwise it will fail.

• Use the “Threshold” datum to adjust how closely the trained color must match the 
inspected color. Increase the value to allow a looser color match, and decrease the value 
to produce a closer color match.
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The ColorSpotCheck tool has the following parameters:

Color space selection options:

Difference calculation method options:
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ColorSpotCheck Tool Setup and Inspection:
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ColorDifference
Purpose: Outputs an image buffer that is the difference between the trained color and the 
current image. The resulting image should be near black when the pixels are close to the 
color that was trained, and will be brighter when they are a different color:

Color image, tool is trained on red:

Resulting output buffer:

Note that the red pixels from the original image are black, whereas all other colors are 
brighter. This tool can be used to detect color changes within an area of an image.

Use:

• This Tool provides two ROIs. The smaller, inner ROI is used to train on a color. The 
outer, larger ROI is used to specify the area of the image that you want to inspect. An 
output buffer will be produced that is the same size as this outer ROI.

• Position the inner ROI over a color and press the Train button in FrontRunner.

• Double-click within the outer ROI, and you will be shown the output buffer produced by 
this Tool. You can insert other steps within this output buffer, such as a Blob or Flaw Tool.
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The ColorDifference tool has the following input parameters:

ColorDifference Tool Setup
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ColorDifference Tool Output Image
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White Balance
This section outlines the white balance functionality for color smart 
cameras in FrontRunner.

White Balance Gain Values
The color channel gain values can be viewed by clicking the Snapshot 
step, selecting the Acquire tab and then activating the Advanced 
parameters as shown below:

The parameters are Red Gain, Blue Gain, and Green Gain. These 
values can be manually adjusted for optimal color fidelity or by using the 
white balance calibration operation outlined in the next section. 
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White Balance Calibration
Before running white balance calibration, place a white object such as a 
piece of paper in front of the camera at the current focus plane. Then 
initiate the white balance operation by selecting the white balance icon 
shown below. The color channel gain is then equalized such that the 
white object appears white.

After white balance calibration, the white balance gain values are updated 
and the results are saved as customer parameters. 

Restore Preset White Balance Configuration
The color smart camera is pre-configured with factory calibrated white 
balance settings. To restore the color channel gain to these preset values, 
select the preset white balance icon as illustrated below:

After this operation, the white balance gain values are restored to the 
factory preset values and saved as customer parameters. 
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Color Channel Options
When a step is inserted in FrontRunner, the Color Channel or Interpolation 
operation can be selected or applied to the step as shown below:

Use Fixed White Balance
The color channel gain values can be fixed by clicking the Snapshot step, 
selecting the Acquire tab and then activating the Advanced parameters. To 
fix white balance parameters, select the Options dropdown and click the 
Use Fixed White Balance option as show below: 
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Device parameters are referred to as camera parameters that are saved 
outside of a job, such that they can be applied globally or independent of 
a job as well as updated outside a job. These parameters include 
photometry settings (gain and exposure), focus, and white balance gain. 

• A new job will always inherit the current “device data” so you do not 
need to re-calibrate the device.

• The device data for focus, photometry, white balance, and 
dimensional calibration exists in two places at all times:

– In the job (copied from the device data at job creation);

– On the device’s global /Config flash folder.

• Whenever the device parameters are calibrated, two things happen:

– The device global data is updated in the /Config flash folder;

– The job loaded in RAM is updated with the new data.

• The Use Fixed White Balance option controls whether the device 
parameters (white balance gains) are updated when the job is loaded 
from flash or downloaded to RAM with the device-wide values, or if 
the values last saved in the job are used instead.

– Normal: Device parameters are updated when the job is loaded 
from flash or downloaded to RAM with the device-wide parameter 
values (from the acqcfg file).

• If a job is opened on the PC or from a flash job slot on the 
device, and if a device parameter is unlocked, the value 
saved in the global device parameter file (acqcf) is used. 

– Job device parameter value (RAM) = Global device 
parameter value (/Config flash folder).
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• Whenever an “unlocked” device parameter is updated, two 
things happen:

– The device global data in RAM is updated;

– The job loaded in RAM is updated.

• When a job is saved to a job slot, the device global data file in 
the /Config flash folder is updated.

– Fixed: Values last saved in the job are used. 

• If a job is opened on the PC or from a flash job slot on the 
device, and if a device parameter is locked, the value saved 
in the job is used.

– Job device parameter loaded in RAM = Job device 
parameter opened (Flash Slot/PC).

– The global device parameter file is untouched.

• Whenever a “locked” device parameter is updated, the job 
loaded in RAM is updated.
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White Balance Implementation
White balance is a processing operation performed to ensure proper color fidelity in a 
captured digital image. The image sensor does not detect light exactly as the human eye 
does, and so some processing or correction of the detected image is necessary to ensure 
that the final image realistically represents the colors of the original image. Proper white 
balance is required to take into account the “color temperature” of the light source, which 
refers to the relative “coolness” of white light. The main purpose of white balance is to 
render neutral colors correctly (gray/white) and to provide consistent color results.

Factory pre-set white balance calibration should be satisfactory for most applications, but 
the color smart camera allows for user adjustment or calibration of the white balance to 
account for exposure to different lighting conditions.

Before white balance:

After white balance:
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Linking Datums to Microscan Link Tags

FrontRunner allows you to link tool parameters to tags within the Global 
Data Service (GDS). This makes it possible to "set and get" the parameter 
values via any GDS-supported protocol, including serial, TCP, 
EtherNet/IP, and PROFINET I/O. Link buttons appear throughout the 
FrontRunner user interface. Linkable output parameters all have a 
Microscan Link icon displayed next to them. 

Datums can be linked to Microscan Link tags by clicking the relevant Link 
button within the datum editor. These buttons only appear next to datums 
that are supported by Microscan Link. The button will display with a green 
background once a link is made.

Clicking on a link button will bring up the Link to External Data dialog 
shown here.
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This dialog will allow you to link the datum to a Microscan Link tag. The 
list of tags to select can be filtered by using the first dropdown menu. The 
choices are:

The list can also be filtered by data type by selecting an item from the 
second dropdown menu. Only tags with a compatible type with the 
currently chosen datum are displayed:

eip Show all tags accessible via EtherNet/IP.

eip.in Only display tags that are part of the EtherNet/IP input 
assembly.

eip.out Only display tags that are part of the EtherNet/IP output 
assembly.

pnio Show all tags accessible via PROFINET I/O.

pnio.in Only display tags that are part of a PROFINET I/O input slot.

pnio.out Only display tags that are part of a PROFINET I/O output slot.

serial / tcp Show all tags accessible via Serial/TCP commands.
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Tags that are already linked will display the path(s) of the relevant datums 
to the right of the tag name in the list. 

To unlink the currently selected datum, click the Unlink button at the 
bottom left of the dialog.
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Switching between PROFINET I/O and EtherNet/IP

Go to the File menu and select Configure Device. Go to the Industrial 
Protocols tab.

Note: When changing protocols, the camera must be rebooted before the 
change will take effect. After clicking OK, you will be given the option to 
reboot the camera now or at a later time.

If you choose No, your newly selected protocol will not be active.
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FTP Image Logging of Pass/Fail Images

FTP Output Step

This step builds an FTP client into a job step. This client can connect to an FTP server to 
upload any image the user requires for storage. The user can upload the snapshot buffer 
directly, or any other buffer that has been processed by other tools. There can be multiple 
FTP steps in a job, each using a different server and directory. 

Theory of Operation

FTP is a client/server protocol and as such, takes time to do its work. The client must 
connect to the server, log in, create or change to the proper directory, and upload a file. 
Files can be large depending on the camera. The larger the file, the longer the FTP time. 
Any use of this step may impact the time to complete one inspection. To help offset some 
of this time, there are two modes of operation. The first opens a connection at start, runs a 
keep-alive mechanism during the job run, and then closes the connection at stop. The 
keep-alive interval is user-configurable. The second mode is to connect to the FTP server 
every inspection. 

If a transfer fails, the step will check to see if the connection is up. If not, it will attempt a re-
connect and a re-try of the transfer. If it fails a second time, the FTP of the image will not 
occur, and will continue to the next inspection.

Potential Use Case

One potential way of using this step is to send failed inspections to a “failed” folder. The 
user fills in the Output Enable with the passing and failing criteria, and when the criteria is 
met, the inspection is transmitted to the FTP server. Be aware that the server must have 
enough storage to handle the number and size of files required. With large file sizes, over 
millions of inspections, one could easily fill the storage and lose inspection data. 
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Settings

Inputs

• Input Buffer – The buffer to FTP from this job (the image).

• Server IP Address – The IP address of the FTP server.

• Port Connection – The network port to use. Default is FTP standard 21.

• UserName – The user name for server login.

• Password – The password for server login.

• Connect Every Cycle – Specifies whether the FTP client will connect to the server only 
once before starting the job and disconnect once when stopping the job, or 
connect/disconnect every job cycle. Default is false or unchecked.

• Keep-Alive Interval – This is an advanced datum that will only display when clicking on 
the A button. Only used when Connect Every Cycle is false/unchecked. The interval at 
which FTP keep-alive packets are transmitted to keep the connection to the server from 
timing out. This value is in seconds. Default is 0 which is a 50 second interval. Requires 
a change to server settings regarding transfer timeouts.

• Num Retries – This is an advanced datum that will only display when clicking on the A 
button. This is used to set the number of times to retry an FTP operation upon a failure. 
The software will re-FTP the image this number of times, then continue on.

• FTP Rate – This setting has six options. Inline, Maximum Rate w/ Drops, 1 per 
Second, 2 per Second, 4 per Second, Every Inspection (No Drops).

• Inline – In this mode the data will be sent in-line with the inspection. This means the 
inspection will not continue until the FTP has completed. This will effect inspection rate.

• Maximum Rate w/ Drops – This will FTP the data as fast as possible, but will lose data 
when FTP is busy in a transfer. This will not impact the inspection rate.

• 1 per Second – This will FTP the data that is current when the timer expires every 
second.

• 2 per Second – This will FTP the data that is current when the timer expires every 500 
milliseconds.

• 4 per Second – This will FTP the data that is current when the timer expires every 250 
milliseconds.
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• Every Inspection (No Drops) – This will cause an inspection to block until the data can 
be sent via FTP. Once the data has been posted to send, the inspection continues. 

• Path – The path of the destination. Default is \microscan.

• FileName – The file name for the destination file. Default is the symbolic name for the 
inspection and buffer. Ex “Insp1.Snapshot1”. This will be appended with a date/time 
stamp when running from the PC, or a timestamp that represents time since boot up 
when running on a camera. If using a color camera, this name will be appended with -
xx8-RawBayerData, where xx will be either RG, GR, GB, or BG, depending on the 
camera type. This will save an 8-bit monochrome Bayer pattern image. Having this 
name appended will allow loading of the image back into the software for viewing in color.

• FileType – .tif or .bmp.

• Output Enable – An expression that evaluates true or false that allows transmission of 
the image to the FTP server. If true, an image will be transmitted to the server. If false, 
the image will NOT be transmitted.

Outputs

• Output File Path – Same as Input value.

• Output File Name – Same as Input value.

Error Codes

FTPOUTPUT_ERR_INVALID_INPUT (163001) – Input datums not set.

FTPOUTPUT_ERR FTPCONNECT (163002) – Failed to connect to the server.

FTPOUTPUT_ERR FTPPUTFILE (163003) – Failed to upload the file.

MS-Linkable Settings

Connect Every Cycle, Server Path, FileName, FileType, Error Code, Output File 
Path, Output File Name.

Training

None.
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I/O Summary

The FTP Output Step provides an I/O summary in the Status Bar located at the bottom of 
the Train Window.

Inputs

Compile Error (yy): xxx when Output Enable compilation fails, or Input data selected.

xxx = Description of compilation error or OK.

yy = Error code.

Outputs: <string>

<string> = <error> for no errors, or displays the error string.

Server Setup

Microscan recommends using the FileZilla FTP server. Install FileZilla then continue as 
described below.

Your PC may require changes to the firewall settings to allow a camera to connect to 
FileZilla. To allow FileZilla access through the firewall, do the following:

Go to windows button and type windows firewall in the search bar. It should bring up the 
windows firewall as shown below:
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Click on New Rule… in the right pane. The following window will appear: 

Be sure the program is selected then click Next. The following window will appear: 
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Click Browse, and go to C:\Program Files(x86)\FileZilla Server. Select FileZilla 
Server.exe and then click Next. The following is displayed:

Be sure Allow the Connection is selected. Click Next through the next two windows until 
you see the following window:
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Enter any name you choose, and click Finish. This should allow FileZilla server through 
the windows firewall.

To configure the FileZilla server after install, click the Edit menu item, then Settings:

Be sure the Listen On These Ports is set to 21. If you don’t plan to not use the Connect 
Every Cycle option, No Transfer Timeout must be set to 0. Make these changes, then 
click OK. 
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Now click IP Bindings and set the IP addresses to which you want to bind this server:

Now configure the users. Click Edit, then Users, then Add: 
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Click OK, then click on the Password checkbox and add a password for this user. 

Now click Shared Folders, then Add. Browse for the folders to give this user access to, 
then click OK.
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Now give this user permissions. Select (at least) Read and Write under Files, and select 
Create and List under Directories, then click OK. 

The server should now allow connections to the assigned IP address, and to the 
directories that were set. This can be tested by downloading the FileZilla client and trying 
to connect to the new server.

Configuring the FTP Output Step

Bring up Visionscape FrontRunner, then connect to a device. Select a job or create a 
new job. Click Editor. This brings up the Step Tree Editor. Insert a new step in the 
position required. Then click Program Control.

Select the FTP Output parameter:
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Select Input Buffer, then select the image to FTP, then click OK:

After the Input Buffer is selected, Microscan default values are populated for Port 
Connection, Connect Every Cycle, Keep-Alive Interval, Server Path, FileName, and 
File Type.



FTP Image Logging of Pass/Fail Images

F
ro

n
tR

u
n

n
er

2

Visionscape FrontRunner User Manual 2-93

Enter Server Address, UserName, and Password. Any default setting can be changed 
now as well. Add an expression to the Output Enable field. If no expression is required, a 
1 value will allow all images to be sent. 

Exit the editor, and run an inspection to be sure it is connected properly to the FTP server. 
At the bottom of the screen, errors will be placed in the Outputs: area. Go to the server 
and switch to the directory provided. The image file with an added date/time (if run from 
the PC) or a time stamp (if run from a camera) will be seen. Open the file and check to be 
sure it is what was expected. If so, download and run the job.
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Output Enable Examples

See page 8-59 of the Visionscape Tools Reference Manual for information regarding 
Expressions.

FTP images for symbology decodes that match a match string.

Set up your symbology match. Click Match String Enable, then enter the Match String.

Click in the Output Enable box, then click the Edit button to the right of Output Enable. 
The following window is displayed:
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Now select Symbology Tool: SYMTool1:

Select Match Status in the right pane, then click the <<Add button, then click OK.

Your window should now look as follows, and if the Symbology Tool match string matches 
the decoded text, it will FTP the image to the inspections\passed directory:
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FTP all failed symbology matches.

Use exactly the same steps as above, then add a ! in front of the expression as follows: 
!Insp1.Snapshot1.SYMTool1.MhStat. This will FTP all images that do not match the 
symbology match string to the server. The FTP screen should look as follows:

FTP an image if the entire inspection fails. 

Use a two inspection model as follows:
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Cross-Subnet Connections

Cross-Subnet Support within Visionscape

Visionscape supports cross-subnet connections to smart cameras. An HTTP-based system 
allows info packets to be obtained from a smart camera via a REST API. The AvpBackplane 
uses a list of user defined IP addresses, creating a thread for each one that will query for 
the info packet for that specific IP address once every 5 seconds. 

The file that contains the list of IP addresses is called ipaddrs.list, and is stored in the 
C:/Microscan/Visionscape/DM folder (root directory may change depending on where 
Visionscape is installed). It is a simple text file consisting of one IP address per line. This 
file can be edited by hand if desired, but there is also a utility dialog in the network overview 
control which provides a UI to do this.

The ipaddrs.list file is monitored by the AvpBackplane, and any changes within the file will 
be processed automatically. However, if an IP address is removed from the list, this change 
will not take effect until all Visionscape processes are terminated, including the AvpBackplane.

Note: Visionscape allows a maximum of 512 network devices. This includes all discovered 
and manually-configured devices.

Note: If a device is both defined in the ipaddrs.list file and also discoverable on a local network, 
the HTTP mechanism will be used as soon as a successful REST response is received 
from the device. Further UDP broadcasts from such a device will be ignored.
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Cross-Subnet Support within the Network Viewer
The network viewer control allows you to set up the cross subnet IP address list. This control 
is used both in FrontRunner and the stand-alone Network Overview utility. Therefore, the 
features described in this section apply to both applications.

The Network Overview window is shown here: 

The IP addrs list button in the Network Overview window brings up the following dialog: 
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• This dialog can be used to view, add, and remove the entries from the ipaddrs.list file. 

• To add an IP address to the list, use the address control at the top and click Add. The 
new address will appear at the bottom of the list.

• To remove an IP address from the list, first select one of the list entries. This will enable 
the Remove button, which will remove the selected entry. 

• The Cancel button will exit the dialog and discard any changes.

The Save and Exit buttons will update the ipaddrs.list file and exit the dialog.

The network view identifies devices which are updated via HTTP by highlighting the IP 
address in bold blue as the first device shown below: 

Such a device can be selected in the list, but the device's network settings cannot be 
changed.
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Miscellaneous

Displaying Important Information About a Camera
To display the important information about a smart camera, simply hover 
the mouse pointer over the camera button. Information includes:

• Type of smart camera

• IP address of PC controlling the camera

• Name of currently loaded job

• Date currently loaded job was created or modified

• Name of PC controlling camera

• IP address and MAC address of the camera

• Version of software on the camera

Configuring I/O Buttons
After a job has been downloaded to the device, and the device is in Run 
mode, you can configure I/O buttons, as shown in Figure 2–28.
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FIGURE 2–28. Configure I/O Buttons

• Add New — When clicked, adds a new IO button.

• Remove — When clicked, removes an existing IO button

• Type — Is one of the following:

– Virtual — Allows you to generate IO data using software.

– Physical — Allows you to generate IO data using hardware.

– Separator — Allows you to group IO data.

• IO Point — Is a number from 1 to 2048.

• Trigger Interval — Is a number from 1 to 9999.

 1
 2
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FIGURE 2–29. I/O Buttons Configured

P2 is Low; P6 and V3 are High
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What I/O Buttons Look Like
Figure 2–30 shows you what the I/O buttons look like.

FIGURE 2–30. I/O Buttons Described

Saving I/O Buttons
The I/O button configuration is saved in the job.

You must have the job in the PC memory to configure I/O buttons. So, if 
you want to add I/O buttons to a running job on a camera, you must do 
either of the following:

• Upload the job to the PC, configure the I/O buttons, and then 
download the job to the camera

• Load or create a job, configure the I/O buttons, and then download 
the job to the camera

Note: Make sure you save the job after you configure I/O buttons.

Note: If there is a job in PC memory that you are viewing or editing, 
be aware that the button configuration that you see is for the job in PC 
memory, and not for the job on the camera.

Physical In I/O Button

Physical Out I/O Button

Virtual I/O Button

Click to send a pulse

Click to send a pulse
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Enabling ROI Masking
To display the ROI Masking Toolbar, from the FrontRunner View menu, 
click Display Tools > Mask Tools.

FrontRunner displays the ROI Masking Toolbar, as shown in Figure 2–31.

FIGURE 2–31. ROI Masking Toolbar

Using this floating toolbar, you can select different drawing tools and draw 
a mask in the ROI of a mask-oriented tool.

You can enable the mask capability of an appropriate tool by selecting the 
tool in the Step Tree. The Lightbulb button in the Masking Toolbar is 
enabled. When you click it, it “lights up”, enables the mask in the tool and 
enables the drawing tool buttons of the toolbar. You can then select any of 
the drawing tools, and draw the mask using the mouse or select the 
“pointer” to return to standard tool selection/insertion with the mouse.
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FIGURE 2–32. ROI Masking Toolbar Descriptions

• Fill ROI — Fills the entire ROI of the masked tool.

• Clear ROI — Erases the entire ROI of the masked tool.

Enable/Disable the mask

Use normal tool insertion

1x1 square pen

2x2 square pen

4x4 square pen

Draw free-style with a brush

Draw solid lines

6x6 square pen

8x8 square pen

10x10 square pen

Draw unfilled rectangles

Draw filled rectangles

12x12 square pen

14x14 square pen

16x16 square pen

Draw unfilled circles

Draw filled circles

Fill connected areas

Erase Mask instead
of Draw Mask
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CHAPTER 3 Camera Calibration

Calibration provides a way for measurement values in your job to be 
converted from pixels to world units (inches, millimeters, etc.). The 
Calibration dialog box provides you with three options for calibrating one 
or more Snapshot steps with a job. For additional information about 
calibration, see Chapter 2 of the Visionscape Tools Reference.

This remainder of this chapter contains information about:

• “Using Robust Calibration” on page 3-2

• “Using Quick Calibration” on page 3-10

• “Using Previously Saved Calibration Data” on page 3-19
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Using Robust Calibration

Note: Before you begin this procedure, you need a valid calibration target 
similar to the one shown in Figure 3–1.

Robust Calibration uses a single Blob tool to find all of the dots on the 
Calibration target. The center position of each dot, in pixels, is compared 
to the position data you enter in the “Robust Calibration: Enter Cal Target 
Dot Locations” screen to calculate forward and backward transform 
matrices that are used to convert pixel values to world, and world values 
to pixels.

FIGURE 3–1. Calibration Target

Use the following procedure to robustly calibrate a camera:

1. Create your job.

2. Place the calibration target under the camera.

3. Click 

4. Adjust the exposure and focus.
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5. Click  again.

6. Click 

FrontRunner displays the Calibration dialog box, as shown in 
Figure 3–2.

FIGURE 3–2. Calibration Dialog Box

7. Under “Calibration Method,” select Robust Calibration.

8. Under “Apply to All Snaps or Just One Snap,” select either of the 
following:

– I Want to Calibrate a Particular Camera, and apply it to all 
Snapshots that use that Camera — You may have a job that 
contains many Inspections and many Snapshots. Many of those 
Snapshots may reference the same camera channel. In this case, 
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using this option, you can calibrate just one of the Snapshot 
steps, and the results are applied to all Snapshot steps that use 
the same camera. Thus, you do not have to calibrate each 
Snapshot individually.

– I Want to Calibrate Each Snapshot Individually — With this 
option, calibration is only applied to the Snapshot step that you 
select.

9. Under “Select the Camera to Calibrate”, highlight (to select) a 
camera.

– If you select “I Want to Calibrate a Particular Camera, and apply it 
to all Snapshots that use that Camera”, “Select the Camera to 
Calibrate” will list the cameras that are being used in the current 
job.

– If you select “I Want to Calibrate Each Snapshot Individually”, 
then each Inspection step is listed, with each of its Snapshots 
underneath.

10. Click Next.

FrontRunner displays the Calibration screen shown in Figure 3–3.
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FIGURE 3–3. Robust Calibration

11. Enter the Calibration Dot locations for all targets.

12. Click Next.

FrontRunner displays a screen similar to the one shown in 
Figure 3–4.
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FIGURE 3–4. Run Calibration Blob Tool

Note: You may need to enlarge the window.

13. Adjust the Calibration Blob ROI.

14. Click Acquire.

15. Click Run Calibration.

FrontRunner displays a screen similar to the one in Figure 3–5.
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FIGURE 3–5. Calibration Results

The grid lines are drawn to give you a sense of the angle of the target 
and the amount of perspective distortion that is present in your image. 
The “Calibration Results” panel on the right side of the dialog will give 
you some statistics on your calibration results. If you are not satisfied 
with the calibration results, click Back and return to the previous page 
where you can adjust your image or Blob parameters and try again.

16. Click Next.
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FrontRunner displays the Finished screen, as shown in Figure 3–6.

FIGURE 3–6. Calibration Finished

17. Select either of the Save options:

– Save Calibration Data from just the Selected Snapshot — This 
button allows you to save the calibration data for just the 
Snapshot that you just calibrated. Then, this data can be 
reloaded into any other Snapshot step in this job or any other job 
by using the Load Calibration Data From File option on the main 
Calibration page.

If you select this save option, FrontRunner displays the Save 
Calibration from Current Snapshot dialog box. Type in a file 
name. Click Save, and then click Finished.

– Save Calibration Data for Entire Job — This button saves the 
calibration data from every Snapshot in your job to a single file. 
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Then, this data can be reloaded into this job or some other job 
using the Load Calibration Data From File option on the main 
Calibration page, and then selecting the File Will Hold Cal Data 
for My Entire Job.

Note: You can only reload this data into a job that has the same 
number of Snapshots.

If you select this save option, FrontRunner displays the Save 
Calibration for Entire Job dialog box. Type in a file name, click 
Save, and then click Finished.

It’s important to understand that when Calibration is performed, the 
data is stored in the Snapshot step(s) of the job, so the job needs to 
be saved when done. You do not need to use the Save options on this 
page unless you want to load the Calibration Data into another job, or 
unless you want to simply have a backup.
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Using Quick Calibration
Use the following procedure to quick calibrate a camera:

1. Create your job.

2. Place the calibration target under the camera.

3. Click 

4. Adjust the exposure and focus.

5. Click  again.

6. Click 

FrontRunner displays the Calibration dialog box, as shown in 
Figure 3–7.

FIGURE 3–7. Calibration Dialog Box
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7. Under “Calibration Method,” select Quick Calibration.

8. Under “Apply to All Snaps or Just One Snap,” select either of the 
following:

– I Want to Calibrate a Particular Camera, and apply it to all 
Snapshots that use that Camera — You may have a job that 
contains many Inspections and many Snapshots. Many of those 
Snapshots may reference the same camera channel. In this case, 
using this option, you can calibrate just one of the Snapshot 
steps, and the results are applied to all Snapshot steps that use 
the same camera. Thus, you do not have to calibrate each 
Snapshot individually.

– I Want to Calibrate Each Snapshot Individually — With this 
option, calibration is only applied to the Snapshot step that you 
select.

9. Under “Select the Camera to Calibrate,” highlight (to select) a 
camera.

10. Click Next.

FrontRunner displays the screen shown in Figure 3–8.

FIGURE 3–8. Quick Calibration
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Note: For information about the Advanced button, see “Advanced 
Options” on page 3-15.

11. Manually enter in the scale factors that you wish to use for calibration.

As the instructions at the top of the page indicate, simply enter a 
distance in pixels, and then a corresponding distance in world units 
(inches, millimeters, etc.) and click Update Calibration. For example, 
say you've taken a picture of the part that you wish to inspect, and 
you know that this part is 2 inches wide. By positioning an ROI over 
that part, or by using the mouse, you might determine that the part is 
240 pixels wide in your image. So, you would enter “240” in the 
“Distance in Pixels” text box, and you would enter “2” in the “Distance 
in World Units” text box. After clicking Update Calibration, the “Pixel to 
World Scale Factor” is updated to show you the scale factor that is 
used to convert pixel values to world values. This scale factor is 
applied in both the X and Y direction. If you wish to have different X 
and Y scale factors, then you will need to use the advanced options.

12. Once you’re done with this page, click Next to move to the Finished 
page.

FrontRunner displays the Finished screen, as shown in Figure 3–9.
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FIGURE 3–9. Calibration Finished

13. Select either of the Save options:

– Save Calibration Data from Just the Selected Snapshot — This 
button allows you to save the calibration data for just the 
Snapshot that you just calibrated. Then, this data can be 
reloaded into any other Snapshot step in this job or any other job 
by using the Load Calibration Data From File option on the main 
Calibration page.

If you select this save option, FrontRunner displays the Save 
Calibration from Current Snapshot dialog box. Type in a file 
name. Click Save, and then click Finished.

– Save Calibration Data for Entire Job — This button saves the 
calibration data from every Snapshot in your job to a single file. 
Then, this data can be reloaded into this job or some other job 
using the Load Calibration Data From File option on the main 
Calibration page, and then selecting the File Will Hold Cal Data 
for My Entire Job.



Chapter 3 Camera Calibration

3-14 Visionscape FrontRunner User Manual

Note: You can only reload this data into a job that has the same 
number of Snapshots.

If you select this save option, FrontRunner displays the Save 
Calibration for Entire Job dialog box. Type in a file name. Click 
Save, and then click Finished.

It is important to understand that when Calibration is performed, the 
data is stored in the Snapshot step(s) of the job, so the job needs to 
be saved when done. You do not need to use the Save options on this 
page unless you want to load the Calibration Data into another job, or 
unless you want to simply have a back-up.
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Advanced Options
Press Advanced to display a page with a new set of controls, as shown in 
Figure 3–10.

FIGURE 3–10. Quick Calibration Advanced Options

This screen gives you more control over the creation of the Forward 
and Backward Transform Matrices that are used for calibration by 
Visionscape. You can even manually modify the matrices directly, 
BUT YOU SHOULD NOT MODIFY THEM UNLESS YOU FULLY 
UNDERSTAND HOW THEY ARE USED.

In general, you will expose the Advanced Options in order to make 
use of the “Create Matrices Using this Data” section.
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FIGURE 3–11. Enter the Scale Factors Dialog Box

1. Using the text boxes in Figure 3–11, enter separate X and Y scale 
factors. Typically, you would do this if your camera is looking at an 
angle, or you know that your camera does not have square pixels.

FIGURE 3–12. Enter the Pixel Location Dialog Box

2. Using the text boxes Figure 3–12, set the pixel location in the image that 
should be considered (0,0) in the World Coordinate System. In most 
cases, you won’t care about this, but if you are trying to get positional 
data back from your inspection, then this may be useful to you.

3. Click Update Matrices once you have entered your values in the text 
boxes, and the Calibration Matrices is updated using your new data.

Clicking Clear Calibration resets the Cal Matrices back to the identity 
matrix, which essentially means that your Snapshot will no longer be 
calibrated. Use this button if you calibrated your Snapshot, but wish to 
return to a non-calibrated state.

4. Click Next.

FrontRunner displays the Finished screen, as shown in Figure 3–6.
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FIGURE 3–13. Calibration Finished

5. Select either of the Save options:

– Save Calibration Data from just the Selected Snapshot — This 
button allows you to save the calibration data for just the 
Snapshot that you just calibrated. Then, this data can be 
reloaded into any other Snapshot step in this job or any other job 
by using the Load Calibration Data From File option on the main 
Calibration page.

If you select this save option, FrontRunner displays the Save 
Calibration from Current Snapshot dialog box. Type in a file 
name. Click Save, and then click Finished.

– Save Calibration Data for Entire Job — This button saves the 
calibration data from every Snapshot in your job to a single file. 
Then, this data can be reloaded into this job or some other job 
using the Load Calibration Data From File option on the main 
Calibration page, and then selecting the File Will Hold Cal Data 
for My Entire Job.
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Note: You can only reload this data into an job that has the same 
number of Snapshots.

If you select this save option, FrontRunner displays the Save 
Calibration for Entire Job dialog box. Type in a file name. Click 
Save, and then click Finished.

It is important to understand that when Calibration is performed, the 
data is stored in the Snapshot step(s) of the job, so the job needs to 
be saved when done. You do not need to use the Save options on this 
page unless you want to load the Calibration Data into another job, or 
unless you want to simply have a back-up.
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Using Previously Saved Calibration Data
When calibration is performed, FrontRunner stores the data in the 
Snapshot step(s) of the job. This means you must save a job after 
calibration is completed.

You do not need to use the Save options on this page unless you want to 
load the Calibration Data into another job, or unless you want to simply 
have a backup.

Use the following procedure to load calibration data that was previously 
saved:

1. Create a new job or open an existing job.

2. Click 

FrontRunner displays the Calibration dialog box, as shown in 
Figure 3–14.
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FIGURE 3–14. Calibration Dialog Box

3. Under “Calibration Method,” select Load Calibration Data from File.

Note: After you select Load Calibration Data from File, the Cal File 
Options are no longer grayed out.

4. Select either of the Cal File options:

– File Will Hold Cal Data for Just One Snapshot

– File Will Hold Cal Data for My Entire Job

5. Under “Apply to All Snaps or Just One Snap,” select either of the 
following:

– I Want to Calibrate a Particular Camera, and apply it to all 
Snapshots that use that Camera

– I Want to Calibrate Each Snapshot Individually
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6. Under “Select the Camera to Calibrate,” highlight (to select) a 
camera.

7. Click Next.

FrontRunner displays the Select Cal File dialog box, as shown in 
Figure 3–15.

FIGURE 3–15. Cal File Dialog Box

8. Highlight (to select) a calibration file (.cal) and click Open.

FrontRunner displays the Calibration Finished screen.

9. Click Finished.

10. Save your job.

Your job now contains the calibration data your saved previously.
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CHAPTER 4 The Part Queue

Every Inspection step maintains a queue of the last n cycle images and 
results. You decide how large the queue will be and what gets stored in it:

• Results and images for every part

• Results and images for passed parts

• Results and images for failed parts

If you activate the Queue, the Part Queue Viewer allows you to upload it, 
and view any of the images and results that were stored on the device at 
runtime.

Note: The Part Queue allows you to review runtime images only.

The remainder of this chapter contains information about:

• “Setting Up and Starting the Part Queue” on page 4-2

• “Viewing Images in the Part Queue” on page 4-8

• “Saving Images and Records” on page 4-10
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Setting Up and Starting the Part Queue
Use the following procedure to set up and start the Part Queue:

1. With a job loaded in FrontRunner, click 

2. In the left pane of the editor, highlight the Inspection step in the Step 
Tree.

3. In the right pane of the editor, click Show Advanced Datums, as 
shown in Figure 4–1.

FIGURE 4–1. Show Advanced Datums Button

FrontRunner displays the Inspection Step properties page with the 
Part Queue properties displayed, as shown in Figure 4–2.

FIGURE 4–2. Inspection Step Properties Page (Partial Page Displayed)

4. Click to the right of Part Queue Enabled to enable the Part Queue.

5. Click to the right of Part Queue Storage Mode and select one of the 
following options for storing images:

Show Advanced Datums
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– Store All Images

– Store Failed Images

– Store Passed Images

– Store Qualified Images (for more information about qualified 
images, see “Storing Qualified Images” on page 4-4)

Note: Clicking Store No Images (the default) stops the Part Queue.

6. Click to the right of Part Queue Size (Cycles) and specify a value to 
indicate the number of images to be stored by the Inspection Step.

Note: Setting the size to 0 disables the Part Queue.

7. Minimize or close the Editor window

8. Click 

9. From the View Menu, select Part Queue.

FrontRunner displays the main Part Queue window, as shown in 
Figure 4–3.
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FIGURE 4–3. Part Queue Main Window

The status bar will increment as each image is saved in the Part Queue.

Storing Qualified Images
Visionscape allows you to store images that meet certain criteria that you 
specify in the Part Queue Qualifier. If Part Queue Qualifier evaluates to 
TRUE, then the image is saved in the Queue; if it evaluates to FALSE, 
then it is not. When an inspection runs and meets the image storage 
criteria, the inspection step saves all camera images in CPU memory for 
that part, which can then be stored to be reviewed at a later time.

Use the following procedure to specify the criteria for storing qualified 
images:

1. Add and select a camera.
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2. Take control of the camera.

3. From the Edit window in FrontRunner, click 

4. Highlight the Inspection step in the Step Tree.

5. Click Show Advanced Datums, as shown in Figure 4–4.

FIGURE 4–4. Show Advanced Datums Button

FrontRunner displays the Inspection Step properties page with the 
Part Queue properties displayed, as shown in Figure 4–5.

FIGURE 4–5. Inspection Step Properties Page (Partial Page Displayed)

6. Click to the right of Part Queue Enabled to enable the Part Queue.

7. Click to the right of Part Queue Storage Mode and select Store 
Qualified Images.

8. Click to the right of Part Queue Qualifier. FrontRunner displays a text 
window and the Edit button to the right of Part Queue Qualifier, as 
shown in Figure 4–6.

Show Advanced Datums
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FIGURE 4–6. Displaying Edit Button

9. Click Edit.... FrontRunner displays the Edit Expression dialog box, as 
shown in Figure 4–7.

FIGURE 4–7. Edit Expression Dialog Box
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10. Notice the various expressions in the Edit Expression dialog box.

11. To add an expression so that it becomes part of the criteria by which 
an image is evaluated, highlight the expression in the lower right 
panel and click Add.

FrontRunner adds the expression to the upper panel.

12. When you are finished adding expressions, click OK.

Note: For detailed information about expressions, see Chapter 8 of the 
Visionscape Tools Reference.
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Viewing Images in the Part Queue
After setting up and starting the Part Queue, you can view images in the 
queue:

1. To upload Part Queue, click 

Note: By default, this clears the camera.

FrontRunner displays a screen similar to the one in Figure 4–8. This 
screen displays:

– A vertical column of images in the queue

– A green (pass)/red (fail) status for the currently selected image

– Cycle information for the currently selected image

– A larger image of the currently selected image



Viewing Images in the Part Queue

T
h

e 
P

ar
t 

Q
u

eu
e

4

Visionscape FrontRunner User Manual 4-9

FIGURE 4–8. Image and Cycle Data

2. Click on the image in the filmstrip on the left that you want to display.
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Saving Images and Records
From the Part Queue, you can save:

• The current image (with or without graphics)

• All images (with or without graphics)

• The current record

• All records

Note: A record is the image, the statistics, and the results of one 
inspection cycle.

Saving Current Image from the Part Queue
Use the following procedure to save the current image from the Part Queue:

1. From the Save drop down menu, click Save Current Image (TIF), as 
shown in Figure 4–9.

FIGURE 4–9. Save Current Image

FrontRunner saves the image in the Jobs folder using the naming convention:

Inspection_CycleNumber_SnapshotNumber.tif
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Saving All Images from the Part Queue
Use the following procedure to save all images from the Part Queue:

1. From the Save drop down menu, click Save All Images (TIF), as 
shown in Figure 4–10.

FIGURE 4–10. Save All Images

FrontRunner displays the Select Folder to Save All Images dialog box.

2. Select a folder and click OK.

FrontRunner saves the images in the folder you specified.

Saving Current Image with Graphics from the Part Queue
Use the following procedure to save the current image, with graphics, 
from the Part Queue:

1. From the Save drop down menu, click Save Current Image with 
Graphics (BMP), as shown in Figure 4–11.
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FIGURE 4–11. Save Current Image with Graphics

FrontRunner displays the Save Current Image With Graphics dialog box.

2. Select a folder and click Save.

FrontRunner saves the image, with graphics, in the folder you specified.

Saving All Images with Graphics from the Part Queue
Use the following procedure to save all images, with graphics, from the 
Part Queue:

1. From the Save drop down menu, click Save All Images with Graphics 
(BMP), as shown in Figure 4–12.

FIGURE 4–12. Save All Images with Graphics

FrontRunner displays the Select Folder to Save All Images dialog box.
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2. Select a folder and click OK.

FrontRunner saves the images, with graphics, in the folder you 
specified.

Saving the Current Record from the Part Queue
Use the following procedure to save the current record from the Part Queue:

1. From the Save drop down menu, click Save Current Record (VRF), 
as shown in Figure 4–13.

FIGURE 4–13. Save Current Record

FrontRunner displays the Select Current Record dialog box.

2. Select a folder and click Save.

FrontRunner saves the record in the folder you specified. The file 
name format is similar to the following:

Insp1_000015643.vrf

Figure 4–14 shows record information for an inspection.
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FIGURE 4–14. Record Information

Saving All Records from the Part Queue
Use the following procedure to save all records from the Part Queue:

1. From the Save drop down menu, click Save All Records (VRF), as 
shown in Figure 4–15.
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FIGURE 4–15. Save All Records

FrontRunner displays the Select Folder to Save All Q Records dialog box.

2. Select a folder and click OK.

FrontRunner saves all records in the folder you specified.

Selecting the Default Folder Location
Use the following procedure to select the default folder location:

1. From the Save drop down menu, click Select Folder, as shown in 
Figure 4–16.

FIGURE 4–16. Select Folder
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FrontRunner displays the Select Default Folder Location dialog box.

2. Select a folder and click OK.

FrontRunner selects the default folder.
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